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3D Scanning for Cultural Heritage Conservation

Factum Foundation was established 
in 2009 as the sister organisation to 
Factum Arte, a multi-disciplinary 
workshop mediating the complex 
boundary between technology and 
contemporary art. In a world in 
which mass tourism, iconoclasm, or 
neglect, amongst other factors, pose 
a serious threat to works of  art and 
culture, the Foundation was formed 
as a not-for-profit organisation ded-
icated to the digital recording and 
rematerialisation of  cultural her-
itage for the purpose of  conserva-
tion, study and dissemination. 

Through its work on endangered 
cultural heritage sites, in museums 
or cultural institutions, and its re-
search into the newest scanning 
and rematerialisation technology, 
Factum Foundation is committed 
to establishing the importance of  
high-resolution 3D recording with 
a view to preserving our shared 
cultural heritage for future genera-
tions. 

 To this end, a large part of  its work 
is dedicated to empowering local 
organisations and individuals with 
the education and technology re-

The Factum Foundation for Digital Technology in Conservation

quired to actively participate in  he 
digitisation of  archaeological sites, 
monuments or artefacts, thereby 
engaging their interest and involve-
ment in culture on a local level. In 
line with the Foundation’s ideals, 
ownership and copyright of  the 
data recorded always remain with 
the institution tasked with looking 
after the object or site on all current 
and future commercial applications. 
In return for this commercial con-
trol, the data is made freely avail-
able for academic, conservation and 
research applications.

Training in 3D recording from Lucida to pho-
togrammetry at Factum Foundation in sum-
mer 2016 – two photographers from Dagestan

A quick introduction to 3D scanning

In recent years, high-resolution 3D 
recording has become part of  a co-
herent non-contact approach to the 
documentation of  cultural heritage 
and to strategies for its long-term 
preservation. This not only creates 
new opportunities for presenting 
culture in both virtual and physical 
ways, but it also transfers skills and 
technologies to create a new econo-
my benefitting local communities. 

The methodology advocated by 
Factum Foundation involves 3D re-
cording both the general shape and 

the surface texture and colour of  
artefacts and sites. The processing 
of  the data depends on its intended 
use, but it is essential that the re-
cording takes place at the highest 
resolution. The data can be archived 
in various forms; raw data offers the 
possibility of  reprocessing in the 
future at higher resolution. Vari-
ous visualisation techniques make 
it possible to stream data safely 
so it can be accessed, studied and 
shared without specialist software. 
3D printing and CNC milling can re-

Facsimile of  The Wedding at Cana by Paolo Veronese (1563. The original is in the Musée 
du Louvre; the facsimile was installed by Factum Arte and the Fondazione Giorgio Cini in the 

original location – the refectory of  the Basilica di San Giorgio Maggiore,   Venice
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sult in accurate re-materialisations 
only if  the data is correctly record-
ed. The conservation community, 
restoration specialists, exhibition 
designers, visitor centres, academic 
institutions, schools, and interest-
ed parties can all benefit from this 
approach. 

Exact facsimiles, made possible 
through advances in 3D record-
ing and output technologies, are 
integral to the work carried out 
by Factum. Nevertheless, a great 
deal of  misunderstanding still ex-
ists about the role they can play in 
cultural heritage preservation. In 
the 21st century, however, a reali-
sation of  the threat posed to cul-
tural heritage is resulting in the 
re-evaluation of  the significance 
of  facsimiles. This is a multidisci-
plinary approach that is helping 
visitors understand the complexity 
involved in preservation and lead-
ing to a renegotiation of  the rela-
tionship between the original and 
the authentic. If  people become 
more conscious of  the fact that vis-
iting monuments such as the tombs 
in the Valley of  the Kings, Luxor 
significantly contributes to their 
degradation, then it is likely that a 
new sense of  public awareness will 

emerge. Through the careful em-
ployment of  facsimiles, we can de-
velop a form of  preservation of  the 
original object that doesn’t deny 
the public a close and intellectual-
ly stimulating interaction with art 
and culture.

Close-range 3D scanning

It is important that the right type 
of  3D recording is undertaken for 
each heritage site or object and 
that the application is consid-
ered prior to the recording phase 
of  a project. In general, the more 
complete the dataset – a complete 
dataset would comprise high-reso-
lution colour, high-resolution sur-
face texture as well as an accurate 
rendition of  shape – the more uses 
it will have for academic, conser-
vation and research purposes. 

For a facsimile, the acquisition of  
high-resolution surface data for an 
object is essential – this requires 
close-range 3D scanning. 

Close-range 3D scanners (working 
distance greater than 8cm and less 
than 100cm) are used to record the 
shape and surface of  objects in de-
tail. Triangulation based 3D laser 
scanners use a laser light and one 

or two cameras to record a subject. 
The distance of  the object to the 
scanner is calculated through trig-
onometry to create a precise map 
of  the surface. Structured light 
scanners use projected patterns of  
light instead of  a laser for trian-
gulation – the camera(s) records 

A coloured render of  3D data from the Hall of  Beauties in the Tomb of  Seti I, Valley of  the  
Kings, West Bank, Luxor

these patterns and calculates the 
position of  every point in the field 
of  view. (See Appendix A for more 
information on the types of  3D 
scanners used by Factum Foun-
dation). The Lucida 3D Scanner 
is an example of  a close-range 3D 
laser system
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The Lucida 3D Scanner

Lucida is a 3D laser scanner cus-
tom-built by Factum Arte with 
financial and logistical support 
from Factum Foundation. Con-
ceived and developed by artist 
and engineer Manuel Franquelo, 
this system is the result of  four-
teen years of  investigation into 
the high-resolution recording of  
the surface of  paintings and relief  
objects

The development of  the Lucida 
3D Scanner

Factum Arte and Factum Foun-
dation have extensive experience 
in employing commercially avail-
able digital technology to record 
cultural heritage sites and objects 
for rematerialisation in diverse lo-
cations around the world – from 
the Valley of  the Kings in Egypt 
to the Musée du Louvre in Paris. 
From the early 2000s, due to the 
complex requirements of  each 
project, Factum has also been 
adapting and improving commer-
cial closerange 3D recording sys-
tems in order to achieve higher 
conservation standards and better 
data. 

Factum Arte started working with 
3D Scanners UK in 2000, using 
and adapting their Reversa scan-
ner for work in the tomb of  Seti I. 
The SETI Scanner, mounted onto 
CNC controlled X, Y, and Z axes, 
was the first variation. The Yabba 
Scanner was the second variation, 
a crucifix scanner specially pre-
pared for work in the British Mu-
seum. The Reversa head mounted 
onto the SETI frame was used 
in the tomb of  Tutankhamun in 
2009, but by this time, the system 
was becoming obsolete. In order 
to improve control of  both the 
hardware and software it was de-
cided that a new scanner would be 
developed in house. 

First sketches of  the Lucida system on a 
napkin 

The idea was to create a laser scan-
ner for conservation that would 
record high-resolution texture of  
any 2.5D surface. 

The first iteration of  the scanner, 
a two-camera laser system em-
ploying linear guides for vertical 
and horizontal movement in 48 x 
48 cm ‘tiles’, was first used in 2011 
to record the preparatory panels 
for The Triumph of  the Eucharist 
by Rubens at the Prado Museum 
in Madrid. Between 2011 and 2013 
new prototypes were created with 
a stable and modular frame to 
support the linear guides and to 
allow the user to scan a number of  
tiles in succession. 

Other changes were made includ-
ing the introduction of  z-axis 
movement – to/from the object – 
which permits re-scanning at var-
ious depths within a single tile; or 
the development of  a simple user 
interface and the creation of  the 
editing, merging and blending ap-
plications, enabling full control of  
the data processing. 

Although research into this tech-
nology is ongoing, the Lucida cur-
rently in use at Factum was fin-
ished in 2015.

Prototype of  the scanning head in wood

First setup to test system basics

Static working scanning head prototype
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The Lucida 3D Scanner is a non-con-
tact laser system designed to record 
the texture and surface of  paintings 
or low-reliefs at high-resolution (up 
to 100 microns), creating datasets 
for study or rematerialisation. The 
scanner is portable, easy to use, and 
requires only mains electricity and a 
low-light environment to function. 

Fitted with two cameras and one 
laser, it records depth information 
that can be handled as both an im-
age and a 3D file. A thin vertical 
strip of  red light is projected onto 
the surface of  the artwork. As the 
strip moves over the surface, it is 
recorded as raw black & white vid-
eo by two cameras positioned at an 
angle of  45 degrees on either side 
of  the laser. The distortions of  the 
line produced by the relief  can be 
rendered to produce an image or 
converted into 3D information. The 
scanning head moves parallel to the 
surface plane of  the object, con-
trolled by linear guides, and is al-
ways at a distance from the surface. 

The Lucida 3D Scanner has a num-
ber of  advantages over commercial-
ly available systems:

A 3D laser scanner for 
conservation

Close-up of  the Lucida two-camera, one laser 
scanning head

1. The Lucida is able to record sur-
faces that are generally considered 
problematic - including shiny, glossy 
or varnished, as well as dark or black 
surfaces - by overcoming the problem 
of  contrast and reflection through 
innovative hardware, and algorithms 
designed to reduce noise without al-
tering surface characteristics. For re-
cording technology to be meaningful 
for cultural applications, it is essen-
tial that the correspondence between 
the surface and recorded data is as 
close as possible. Understanding the 
relationship between noise and infor-
mation is critical.

2. The Lucida is unique in storing 3D 
information in the form of  raw tonal 
video, making it possible to re-process 
the data in the future at higher reso-
lutions or with new technology. This 
is a radical innovation that reflects a 
deep understanding of  the needs of  
the conservation community. Other 
scanning systems automatically pro-
cess the recorded data into a three-di-
mensional point cloud or mesh, which 
results in an irreversible abstraction 
and a permanent loss of  information. 
Lucida also generates a series of  files 
for use: AVI (Video), RIS (3D), TIFF 
32 bit and 16 bit (greyscale depth-
map) and TIFF 8 bit (shaded render-
ing).

3. Another innovation is the use of  
increasingly powerful image  stitch-

ing software as an integral part of  
the process (Adobe Photoshop and/or 
PTGui). After the RIS files have been 
edited to fill holes and remove noise, 
the shaded renders are corrected us-
ing projective geometry and stitched 
together. They can then be ‘switched’ 
for the 32bit greyscale data that con-
tains the depth information. This 
‘edited’, ‘merged’ and ‘aligned’ file 
can be exported into software like 
Artcam as an STL or OBJ (standard 
3D formats) and used to rematerialise 
the 3D data in physical form with the 
surface character of  the original. 

It is by virtue of  these steps that the 
recorded data can be processed and 
accessed without specialised 3D soft-
ware that tend to be expensive and 
require regular, often costly, updates.

Colour image of  the standard 
board – which contains problematic 
surfaces including shiny and very 
dark surfaces – photographed with 
raking light to highlight relief

Render of  the 3D data of  the stan-
dard board obtained with Lucida
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4. The render of  the 3D data (a shad-
ed 8-bit TIFF file) can be integrated 
with other image files to produce mul-
tilayered browsers that can accurate-
ly integrate infra-red, X-ray, colour 
and other types of  information in 
conservation reports, historical imag-
es and various forms of  forensically 
accurate analysis. Multi-layered files 
are helpful to researchers and conser-
vators because they provide an infor-
mation-rich, accurate, objective and 
meaningful method for monitoring 
the condition of  the artwork. 

The Lucida 3D Scanner has been 
used in major cultural institutions 

Credits

Manuel Franquelo: Concept and 
design of  electronics, mechanics, 
optics, and software.

Fabricated and tested in Factum 
Arte by Carlos Bayod, Jorge Cano, 
Dwight Perry, Carlos Alonso, 
Nicolás Díez, Manuel Franquelo 
Jr, Guendalina Damone, Enrique 
Esteban and Aliaa Ismail under the 
supervision of  Manuel Franquelo.

Recording the Hereford Mappa Mundi at Hereford Cathedral with the Lucida 3D Scanner

to provide data that will become in-
tegral for conservation, including the 
Musée du Louvre (Paris), the Nation-
al Gallery (London) and the Prado 
Museum (Madrid). 

The Lucida 3D Scanner
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1
Welcome. 
Let’s get started

<<<
Damaged canvas, detail
3D scanned in 2011 in Factum Arte, Madrid
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1 Let's get started 1 Let's get started

Specifications How does it work?

Laser diode
Manufacturer and model: Laser Components ADL-65075TA2
Type: Auto Power Controlled Laser Diode. Stable light power output, 
compact size, high brightness laser light source
Wavelength: 650 nm
Power: 5 mW

Cameras
Manufacturer and model: IDS UI-1221LE-M-GL
Type of cameras: Monochrome
Sensor: CMOS Mono by Aptina Imaging
Lens: Sunex DSL-300 EFL=17.1 f/4.2
Data transmission speed: max 25 Mbytes/s per camera
Interface: USB 2.0
Resolution: 752 x 480 pixels

Microcontroller
Chip: 8-bit Atmel AVR Atmega 328
Clock speed: 16MHz
Operating Voltage: 5V

Linear motion
Manufacturer and model: Haydon Kerk RGS06 Motorized hybrid 
linear rails & actuators

Data features
File formats: 3D (RIS), 3D (32 bit-TIFF), 3D (16 bit-TIFF), 2D render 
(8-bit TIFF), raw video (AVI) 
Point resolution: 10,000 points per cm2
Megabytes per m2: RIS (420 MB), 3D depthmap 32bit-TIFF (420 
MB), 2D render 8bit-TIFF (88 MB), AVI (272 GB)

Designed and developed by the artist Manuel Franquelo, Lucida has 
been created to obtain contact-free, high-resolution 3D data out of 
the surface of paintings and low-relief objects.
The system projects a thin beam of red light onto the surface of 
the painting. As the beam moves across the object the distortions 
caused	by	the	surface	fluctuation	are	recorded	by	two	video	cameras	
positioned adjacent on the assembly either side of the laser. The vid-
eo footage is archived as raw data as well as processed as a tonal 
depthmap.

Scanning features
Depth	of	field:	25	mm
Maximum scanning depth using Z axis: 200 mm
Distance to the target: 65-90 mm
Maximum scanning area (m2): 
Only limited by storage capacity and structural frame
Scanning speed (m2/h): ca. 0.25 
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1 Let's get started 1 Let's get started

Components

What’s in the case?

For product updates, new components and accessories please visit: 
www.factum-arte.com

Components

 Ref.  Units  Component

 01  1  Calibration arm

 02  1  Calibration stand

 03  1  Calibration dowel pin

 04  1  Calibration threaded handle

 05  1  Scanner head

 06  1  Shim plate

 07  1  Horizontal linear guide

 08  1  Horizontal channel

 09  2  Carriage connection plate

 10  2  Vertical linear guide

 11  1  Backing frame

 12  8  Stand-off

 13  4  Carriage

 14  2  Carriage plate

 15  1  Brake connecting profile

 16  1  Brake connecting plate

 17  1  Brake handle

 18  1  Tower profile 1000 mm + Profiles + Guide rods

 19  1  Tower cap

 20  1  Square

 21  1  Square cap

 22  1  Tower plate

 23  2  Beam

 24  1  Threaded plastic piece

 25  1  Lead screw

 26  2  Bearing

 27  2  Bearing mount

 28  1  Hand wheel

 29  4  Carriage

 30  2  Guide
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1 Let's get started 1 Let's get started

 31

 32

 33

 34

 35

 36

 37

 38

 39

 40

 Ref.  Units  Component

 1

 1

 1

 4

 2

 4

 4

 4

 4

 4

 Digital caliper

 Digital caliper connecting plate

 Base plate

 Carriage

 Guide 1750 mm

 Profile 1750 mm

 Profile 270 mm

 End plate

 Adjustable oot

 Foot cap

 41

 42

 43

 44

 45

 46

 47

 48

 49

 50

 51

 52

 53

 54

 1

 1

 1

 1

 1

 1

 1

 1

 1

 1

 1

 1

 1

 1

 Controllers box and wires

 Controllers AC adaptor

 Power cable

 USB cables set

 USB extensions set

 Allen keys set

 Micro-screwdrivers set

 Laptop

 Laptop AC adaptor

 Laptop mouse

 Laptop bag

 Long rectangular case

 Large square case

 Spanners set

 Ref.  Units  Component

Components. Accesories

Components Components. Screws and nuts

 Ref.  Units  Component

 A  2

 B  2

 C  4

 D  8

 E  2

 F  8

 G  16

 H  8

 I  2

 J  2

 K  4

 L  8

 M  4

 N  4

 O  3

 P  4

 Q  16

 R  2

 S  2

 T  2

 U  16

 V  16

 W  58

 X  8

 Y  4

 Z  4

 M6 x 24 Socket head cap screw

 No 6-32 x 1/2 Socket head cap screw

 M6 x 5 Socket countersunk head screw + nuts

 M3 x 5 Socket head cap screw

 M6 x 15 Socket head cap screw

 M12 x 50 Socket countersunk head screw

 M8 x 25 Bosch FS7 + Nuts

 M5 x 14 Socket head cap screw

 M5 x 20 Socket head cap screw

 M5 + Nuts

 M5 x 20 Socket head cap screw

 M6 x 20 Socket countersunk head screw

 B12 x 40 Socket head cap screw

 4.5 x 24 mm Cylindrical dowel pin

 M3 x 0.5 Socket head cap screw

 No 6-32 x 1/2 Socket head cap screw

 M6 x 45 Socket head cap screw

 M6 x 15 Socket head cap screw

 M8 x 25 Bosch FS7 + Nuts

 M12 x 22 Socket countersunk head screw

 M8 x 40 Hexagonal head

 M5 x 10 Pan cross head + Nuts

 M3 + Nuts

 M6 x 15 Socket countersunk head screw

 M8 x 40 Socket head cap screw

 M12 x 90 Threaded rod + Nuts

For product updates, new components and accessories please visit: 
www.factum-arte.com
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Setting up

2

<<<
Hereford Mappa Mundi, c. 1300, ink on vellum, detail
3D scanned in 2012 in Hereford Cathedral, England
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2 Setting up 2 Setting up

Step 01/16

Components:
40 (4x) Foot cap
39 (4x) Adjustable foot
37	(2x)	Profile	270	mm
36	(2x)	Profile	1750	mm

Step 02/16

Components:
38 (4x) End plate
35 (2x) Guide 1750 mm
34 (4x) Carriage
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2 Setting up 2 Setting up

Components.
33 (1x) Base plate

Step 03/16 Step 04/16

Components:
30 (2x) Guide
29 (4x) Carriage
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2 Setting up 2 Setting up

Step 05/16

Components:
32 (1x) Digital caliper connecting plate
33 (1x) Digital caliper

Step 06/16

Components:
24 (1x) Threaded plastic piece
23 (2x) Beam
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2 Setting up 2 Setting up

Step 07/16

Components:
28 (1x) Handwheel
27 (2x) Bearing mount
26 (2x) Bearing
25 (1x) Leadscrew

Step 08/16

Components:
22 (1x) Tower plate
21 (1x) Square cap
20 (1x) Square 
18	(1x)	Tower	profile
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2 Setting up 2 Setting up

Step 09/16

Components:
22 (1x) Tower plate
21 (1x) Square cap
20 (1x) Square 
18	(1x)	Tower	profile

Step 10/16

Components:
19 (1x) Tower cap
14 (2x) Carriage plate
13 (4x) Carriage
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2 Setting up 2 Setting up

Step 11/16

Components:
17 (1x) Break handle
16 (1x) Break connecting plate
15	(1x)	Break	connecting	profile

Step 12/16

Components:
12 (8x) Stand-off
11 (1x) Backing frame
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2 Setting up 2 Setting up

Step 13/16

Copmponents:
10 (2x) Vertical linear guide
09 (2x) Carriage connection plate

Step 14/16

Components:
08 (1x) Horizontal channel
07 (1x) Horizontal linear guide
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2 Setting up 2 Setting up

Step 15/16

Components:
06 (1x) Shim plate
05 (1x) Scanner head

Step 16/16

For product updates, new components and accessories please visit: 
www.factum-arte.com

Support: +34 915 500 978 / carlos@factum-arte.com / 
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2 Setting up 2 Setting up

Photo guide Photo guide

You can also approach the setup of the Lucida using the following 
steps accompanied with images. Some users may prefer this option. 

Step 1: Prepare the legs for the rails 

1.1 Match the black triangle 
brackets to the aluminium legs. 
Make sure the edges perfectly 
line up. The legs support the en-
tire structure - it is important to as-
semble them correctly.

1.2 Use the silver screw heads 
to attach the triangle brackets to 
the legs.

The highlighted 
section goes inside 
the grooves of the 
rails and locks 
when tightened.

1.3 Repeat the procedure for the 
other side of the leg and for the 
other three legs. 

Step 2: Attach the legs to the rail and the feet to the legs

2.1 Line up the legs so the two screws connect with the groove on 
the rail. The four legs must be equidistant from the centre to bal-
ance the weight distribution. 

Push the screws towards the outer edge of the slots to make for 
easier	access	and	facilitate	the	fixing	and	removing	process.
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2 Setting up 2 Setting up

Photo guide Photo guide

2.2 Secure the feet: simply screw 
the feet into the threaded hole on 
bottom of supporting legs.

Step 3: Secure the plate onto the rails

The base structure consists of two connected rails; each of the rails 
contains two carriages. The carriages are mobile and can be ad-
justed to the perforated screw holes on the aluminium plate.

3.1 Align the plate to the carriag-
es. Each carriage has four points 
of attachment. 

3.2 Attach using the designat-
ed M4 x 16mm screws. Gently 
screw all four screws to make 
sure the plate is well aligned. 
Then tighten using the allen key. 

Step 4: Secure base plate to mast

The base plate has 12 holes. To attach it to the base of the mast 
requires only four of these holes. This allows for three possible po-
sitions for the mast: one at the front, a second in the middle and a 
final	one	at	the	back.	The	position	that	is	most	frequently	adopted	is	
with the mast located at the front as will be shown in Step 4.

4.1 Place the mast on a table. 
Use the top four holes and make 
sure before attaching any of the 
screws that the rails on the mast 
are facing upwards and away 
from the base plate.

4.2 Once the composition is well 
aligned, screw the plate onto the 
base of the mast using four M8 
screws.
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2 Setting up 2 Setting up

Photo guide Photo guide
It is important to make sure that 
the plate is 100 % perpendicular 
to the mast and the screws well 
tightened. This ensures the mast 
is parallel to the wall during re-
cording – the data recorded will 
be accurate. Any tilt in the verti-
cality of the mast will reduce the
range of the scanner and produce 
data at an angle (more detail in 
Scanner operation).

Step 5: Secure stabilising pyramid to mast and plate

The stabilising pyramid is an aluminium triangular bracket similar to 
that used for the preparation of the supporting legs in Step 1 The sta-
bilising	pyramid	helps	fix	the	position	of	the	mast	in	relation	to	the	base	
plate and maintains the verticality of the mast during the recording. 

5.1 Use the same screws shown 
in Step 1 to attach the bracket to 
the mast. 

5.2 Use socket-head screws to 
attach the bracket and mast to 
base plate.

Again, it is important to make 
sure the base plate and mast are 
100% perpendicular. The silver 
metal tracks on the mast (high-
lighted) face forwards. 

5.3 Place the protective cover on 
the triangular bracket. 

Step 6: Attach beams to the silver base plate

6.1 One of the beams has three small 
holes around a larger one. Insert the 
black, plastic threaded tube into the 
hole of this beam.  Make sure that 
the triangular face is aligned with the 
three holes on the beam; attach the 
two	pieces	together	using	flat	head	
M3 x 16mm screws. 
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2 Setting up 2 Setting up

6.2 The beam comprising the 
threaded tube is attached to front of 
the scanner, the plastic piece facing 
inward.

6.3 The beams are attached 
to the plate using socket 
head cap screws. Attach 
both beams at the back of 
the base plate and make 
sure that they are properly 
fixed	by	attempting	 to	move	
them.

Step 7: Attach mast to base structure plate

7.1 Evenly space the four carriages so that the structure comprising 
mast, beams, and silver plate can be attached to the base plate by 
means of the two beams.

7.2 Carefully lift the vertical struc-
ture to a standing position and 
place onto the base structure.

7.3 Carefully align the holes on the 
carriages to the holes on the beams 
and	make	sure	there	is	flat	contact.	
Screw in using M4 x 16mm.

Step 8: The z-axis component

The components required in Step 8 are: the threaded rod, the bearings, 
the	bearings	fixture	and	the	nut	and	bolt	screws.	

8.1 First, place the two bearing 
fixtures	onto	 front	and	back	of	 the	
base plate; attach them with to it
using nut and bolt screws.

8.2 Now place one of the bearings 
into	 the	 fixture	 at	 the	 front	 of	 the	
scanner. 

Photo guide Photo guide
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2 Setting up 2 Setting up

8.3 Bring the threaded rod and pass 
it	through	the	bearing	fixture	on	the	
back of the plate, and through the 
first	beam.	Then,	 thread	 it	 into	the	
second beam until it is close to the 
front	bearing	fixture.

Photo guide Photo guide

8.4 Get the other bearing and insert 
it on to the rod, now slip the rod with 
the bearing on it into the bearing 
fixture.	Tighten	the	screw	at	the	top	
of	the	bearing	fixture	to	secure	the	
bearing	in	place	and	fix	the	handle	
on to the protruding section of the 
rod.

8.5	Rotate	the	handle	to	test	the	sensitivity	of	the	motion.	The	final	result	
should allow for motion sensitive to a couple of millimetres. If you are not 
achieving	this,	loosen	or	tighten	the	screw	at	the	top	of	the	bearing	fixture	
and try rotating the handle until the required level of precision is acquired.

Step 9: Attaching the brakes to the backing frame

The backing frame goes onto the rails of the mast and its position can 
be manually adjusted. However, to secure it into position, brakes are 
needed. A simple mechanical brake system is used to facilitate the 
process of moving and securing the backing frame. The brake system 
consists	of	a	handle,	an	aluminium	section,	an	aluminium	angle,	a	flat	
bar with perforated holes and a set of accompanying screws.

9.1 Start by setting up the brake 
system:	place	the	flat	bar	on	top	of	
the two carriages on the back of the 
backing frame.

9.2 Then place the aluminium 
section attached to the aluminium 
angle and handle as shown in the 
image.

9.3 Now pass the screws through 
the bar and the carriages; screw 
them into the backing frame using 
four long screws (two on each car-
riage) while pushing both the car-
riages inwards at the same time to 
make sure that both of them are
equidistant from the carriages fac-
ing them.
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Photo guide Photo guide

Note that the distance between the carriages must be equal so that 
the backing frame can move with ease while the rails are connected 
to all four carriages.

Step 10: Positioning the backing frame 

The	final	step	is	to	slide	the	backing	frame	onto	the	mast.	This	can	be	
complicated, since most of the time the distance between the carriag-
es	is	either	too	tight	or	too	loose	to	fit	on	to	the	rails	of	the	mast.	

If the distance between the carriages is too tight then backing frame 
will not be able to slide on: in this case, loosen the carriages on one 
side and try to pass it through from the top. If the distance is too great, 
the backing frame can be placed onto the mast and the distance ad-
justed while the frame is in position.

10.1 Slide the frame on to the mast 
using the guides to position the car-
riages; make sure the knob from the 
brakes	easily	fits	inside	the	grooves	
on the Lucida mast. Make sure the 
wheels are touching and rolling on 
the mast rails.

10.2 If the wheels on the carriages 
need to be tightened or loosened 
for a better grip to the mast, take 
the appropriate Allen key and undo 
the lock in the carriage which al-
lows the wheels to be adjusted.

10.3	 Now	 use	 a	 flat	 head	 screw	
driver to adjust the wheels into the 
desired position and lock structure 
into place again using the Allen 
key.
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Wiring

03. Connect the USB cable to Camera 1, note the orientation
04. Connect the USB cable to Camera 2

07. Make sure the power switch is turned off 
08. Connect the control box to the AC transformer

01. Connect the vertical slide motors, connections are interchangeabe
02. Connect the horizontal slide motor

05. Connect the ribbon cable to the PCB on top of the scanner head
06. Plug in the AC transformer, do not connect it to the control box yet

Wiring

09. Connect the USB cables of the cameras to the extensions
10. Connect the ribbon cable to the PCB of the control box

11. Connect the USB cable to the Arduino Proto Shield
12. Connect one camera USB cable to one of the USB 2 ports 

13. Connect the other camera USB cable to one of the USB 3 ports
14. Connect the Arduino USB cable to another USB 3 port

15. Connect the mouse to the free USB-SATA port 
16. Switch power on, the drivers’ status LED will turn green
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Startup process

<<<
San Giorgio (Polittico Griffoni), Ercole de’Roberti, 1472-1473
Tempera on poplar, detail of the back 
3D scanned in 2012 in Fondazione Giorgio Cini, Venice

3
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Quick start guide The scanning tile

The scanning tile consists of a standard area of data composed of 20 
horizontal stripes 26 mm wide with a merged overlap of 10%

https://vimeo.com/8261186
password: factum53

See this video for a a step-by-step tutorial covering these areas:

Positioning;	Wiring;	The	Scanning	Application;	Configuring	Arduino’s	
COM Port; How to attach the calibration tool; Calibration; Planning a 
New Session; New Session. 
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Positioning the scanner

Distance to the target, from the front of the backing frame to the 
center	of	the	depth	of	field:	195	mm
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Scanning area

8 full scanning tiles with an approx. 10% overlap: 891 x 1875 mm
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X axis movement

Maximum extent on the X axis: 1950 mm
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Y axis movement

Maximum extent on the Y axis:  1050 mm
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Z axis movemenrt

Maximum extent on the Z axis:  200 mm
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2 Startup
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The
Scanning
Application

4
The scanning application was programmed (...) 

<<<
San Vincenzo (Polittico Griffoni), Francesco del Cossa, 1472-1473
Tempera on poplar, detail of the back 
3D scanned in 2013 in The National Gallery, London
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4 Scanning application 4 Scanning application

5

1	Menu	I:	buttons	console,	first	level	options	(see	oposite	page)
2 Menu II: buttons console, second level options.
3 Main window: it shows the 3D data as shaded as it is processed.
4 Streaming window: it shows the frames captured by each camera.
5 Navigation window: it shows the progress the scanning session.

Reccommended screen resolution: 1920 x 1080 px. 

Support: factum@factum-arte.com / +34 915 500 978

4

The user interface

Home menu
The graphic user interface of the Scanning Application has been 
designed to guide the operator step by step throughout the process. 

New session: create a new scanning session and movement control.
Settings: adjust settings, movement control and live video streaming.
Calibration: wizard-assisted calibration process.

1

2

3



Lucida Lucida74 75Operator's manual Operator's manual

4 Scanning application 4 Scanning application

Calibration

03.	Check	on	Cam	1	and	Cam	2	that	the	Calibration	profile	can	be	
seen	completely	and	the	line	is	clearly	defined.	
04. If necessary, press ‘Back’ and open the Settings menu to adjust 
the Laser intensity to a middle level (4-6). 
05. Press ‘Back’ and open the Calibration menu again. Press ‘Pulse’.

01. Open the Calibration menu and follow the on screen instructions.
02. Press ‘Pulse’ to trigger one shot from each of the two cameras.
 

<

How to attach the calibration tool

1. Align the calibration tool parallel to one of the vertical guides and 
make	sure	that	both	flat	sides	are	fully	in	contact.	
2. Insert the threaded handle and gently tighten the calibration tool to 
the backing frame through the slot. 
3. Move the scanner head upwards (-Y) until the carriage touches 
the positioning rod of the calibration tool. (See Settings, page 00).
4.	IMPORTANT:	Once	the	calibration	tool	is	fixed	do	not	move	the	
scanner head upwards (-Y) as one of the carriages is now locked!
5. Move the scanner head horizontally (-X or +X) until the laser beam 
hits	the	centre	of	the	edge	of	the	calibration	profile.
6.	Adjust	the		laser	intensity	until	you	see	a	thin,	defined	line.	Keep	
the	tool	fixed.	Now	you	are	ready	to	initiate	the	Calibration	process.	
7. Once the Calibration process is done simply release the threaded 
rod and carefully remove the calibration tool from the backing frame.
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Support: factum@factum-arte.com / +34 915 500 978

Calibration

8. Now repeat the operation. Green dots represent the view of the 
calibration	profile	as	seen	from	Camera	2.
09.	Mark	on	the	screen	the	4	corners	for	the	profile	and	press	‘Apply’

06. The four sections in the main window show the four corners of 
the	calibration	profile.	Red	dots	represent	the	view	from	Camera	1.
07.	Mark	on	the	screen	the	4	corners	for	the	profile	and	press	‘Apply’
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4 Scanning application

Calibration

10.	The	final	alignment	consists	of	manually	overlapping	and	aligning	
the homography (dots) of Cam 2 (green dots) as closely as possible 
over the homography from Cam 1 (red dots) on each of the 4 corners

11. Click on one of the 4 corners of the main window and use the 
arrow keys to place the green dots precisely on top of the red dots.
12. Repeat this operation for each corner as many times as needed..
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Calibration

18.	The	calibration	matrix	is	saved	as	an	XML	file	in	the	folder	Data.

15. ‘Calibration successfully done’ will appear on screen.
16. Press ‘Accept’. The new calibration matrix has been saved.
17. The scanning application will go back to the Home menu.

Calibration

13.	The	final	alignment	step	should	be	done	carefully	and	the	two	
homographies must exactly overlap.
14. Take your time to adjust each corner and press then ‘Done’.

<

If you want to watch videos about the Calibration process please visit:
www.factum-arte.com
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Press	‘Save’	or	‘Back’	to	go	the	Home	menu	once	you	have	finished..

support.Lucida@factum-arte.com / +34 915 500 978

System settings: to turn Off/On internal processes in the application
Camera settings: to adjust parameters of the video capture.
Movement: to control the displacement of the scanner head.

Settings

From the Settings menu you can modify certain parameters before 
starting a New Session. The Settings are set by default as shown in 
the image below. 

The Video preview window shows live streaming from each of the 
two cameras in order to check parameters like the Laser intensity, 
etc.	The	red	lines	help	to	determine	the	center	of	the	depth	of	field.	
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Movement

X- / X+ / Y- / Y+
Moves the scanner head in the four directions of the scanning plane
Set origin
Sets the current position of the scanner as the new 0,0 position
Go to origin
Moves the scanner head to the current 0,0 position
Go to target
Moves the scanner head to an X,Y position marked on the window

The position of the scanner head is shown in the Navigation window.

IMPORTANT: 
The Scanning Application remembers the origin (0,0 position) if you 
start a New Session and even if you Exit the Application. The original 
position will only be forgotten if the Arduino cable is disconnected.  

Therefore, do not disconnect the Arduino cable if you intend to do 
successive recording sessions and keeping the scanner head at the 
same 0,0 position. 

Camera settings

Threshold
Sets the segmentation from the grayscale image.
Range: 1 to 000 (default: 030).
Exposure
Sets the quantity of light reaching the camera sensor.
Range: 1 to 000 (default: 180).
HDR
Captures two frames at different exposure levels and combines them 
to produce an image representative of a broader tonal range.
Options: Off / On (default: On).

Auto height 
Options: Off / On (default: On).
Auto factory roofing
Options: Off / On (default: On).
Append stripe
Options: Off / On (default: On).
Record to video file
Options: Off / On (default: On).

Laser intensity
Range: 1 to 10.

What is the correct Laser intensity level?
The Laser intensity level should be set according to the surface 
characteristics of the object to scan and its capacity to absorb light. 
Lower levels of Laser intensity make the laser beam thinner (Fig. 1), 
which can result in loss of data. Higher levels make the laser beam 
thicker and brighter (Fig. 2) but increase the amount of so called 
speckle-noise, which can reduce the quality of the scan. Therefore, 
the correct Laser intensity level for a particular object is the minimum 
possible to record all data without loss.

      Fig. 1

      Fig. 2 

System settings
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Planning a New session

  Out of range. 
  Too close.

  Out of range. 
  Too far.

02. If the laser beam disappears from the Preview window this 
means	the	recording	is	out	of	the	25	mm	(depth	of	field)	range:

IMPORTANT: Before starting a New Session check the distance to 
the painting on the whole area you wish to scan. Use the Preview 
window in the Settings menu to make sure that the laser beam is 
always	within	the	cameras’	depth	of	field.	

03.	Confirm	that	the	backing	frame	of	the	scanner	is	parallel	to	the	
object and then rotate the hand-wheel to move the scanner forward 
or backwards along the Z axis, until you get to the right distance.

19

Planning a New session

01. Set the scanner at the right distance to the object, so the laser 
beam is always visible within the Preview window:

  Too close...

  Too far...

  Correct distance!

18
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Planning a New session

  Laser intensity: 3
  Threshold: 30
  Exposure: 20

  Laser intensity: 3
  Threshold: 255
  Exposure: 180

05. You can also adjust the Camera settings (default values are 
Threshold: 30, Exposure: 180) for different results, for example:

IMPORTANT: Before starting a New Session check the Laser inten-
sity and the Camera settings on the whole area you wish to scan. 
Slight variations in the material, color, tone, shine, etc. may result in 
loss of data or excess speckle noise. If there is large variation in the 
different areas, choose values that will allow you to scan more area.

If you want to watch videos about Planning a New session please visit: 
www.factum-arte.com 

Planning a New session

04. Now set the Laser intensity at the correct level for the object that 
you wish to scan - it changes with each material -, for example:

  Laser intensity: 10
  Too high...

  Laser intensity: 1
  Too low...

  Laser intensity: 3
  Good!
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New session: inserts Name and path in the session Folder.
Movement: controls the Movement of the scanning head.
Scanning area: controls the Scanning area and Number of stripes.
System info: indicates Laser temperature and Battery voltage.

Support: factum@factum-arte.com / +34 915 500 978

Press ‘Back’ to go to the Home menu if you wish to modify Settings.

New session

Before starting a New Session make sure that the Calibration and 
the Settings are properly saved. Press ‘New session’ to record a new 
scan. The Scanning Application will guide you through the process. 

IMPORTANT: Make sure that the laptop and the scanner are 
properly connected to mains and/or the batteries are fully charged 
before starting a New Session.
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05. Use the arrow keys to position the scanner head at the beginning 
(top-left corner from the user’s point of view) of the scanning area.
06. Press ‘Set origin’. The position of the head is now set to 0,0.

Scanning a tile

<
<

07. Scanning area. The default scanning area is set to one tile:
Top left corner (x, y): 0,0; Bottom right corner (x, y): 4800, 4680.
08. For scanning a tile don’t modify the Scanning area. Press ‘Scan’.

<
<

<

Scanning a tile

01. Type the name of the new scanning session
02. Press ‘Browse’ to select a folder where the session will be saved 
03. Press ‘Next’.

<
<
<

04. ‘Select type of project’. Click ‘Live’ if you want to create a session 
with live video. Click ‘File‘ if you want to create a session using a 
pre-recorded	video	file	(default:	Live).	Press	‘Next’.

<
<
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IMPORTANT: Do not press any button in the Application while 
scanning. If you wish to stop the process at any time press ‘Cancel’. 
You will need to start a New session if you wish to continue scanning. 

Live information of the progress of the session:
Streaming window: shows the frames captured by each camera.
Navigation window: shows the progress the scanning session.
Main window: shows a rendering of the 3D data as it is processed

Scanning a tile

Once you press Scan the message ‘Scanning from live...’ will  appear 
on screen and a full tile of 20 stripes will be recorded automatically. 
This process will take approximately 1 hour to complete.

The Application will indicate the progress of the session as follows: 
‘Current stripe’: from 1 to 20 and
‘Processed’: percentage of stripe recorded.
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Scanning a tile

11. Click in the Navigation window to zoom on the scanned data and 
use the mouse wheel to zoom in and out the rendered image.
12. Drag in the Navigation widow to pan through the rendered image.

13. Press ‘Back’ to go to the Home menu. The rendered images in 
the Navigation window will remain and the Main image will disappear.
14. If you press ‘New Session’ all the windows will reset.

<

Scanning a tile

09. The rendering of the processed 3D data is shown in the Main 
window at the end of each stripe. If you Cancel a session you will 
lose the data of the current stripe, but the previous stripes are saved.  

10.	When	the	tile	is	finished	the	full	rendering	of	the	scanned	tile	will	
also appear in the Navigation window, as well as in the Main window. 
At this point he data is already saved, no further action is needed. 
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When is it necessary to re-scan a specific area?
A good scan captures as much information as possible. Captured 
data is represented on the screen with a grey tone whereas absence 
of data is shown as black. 

If you see a black area in your data it is necessary to re-scan. The 
most common reasons for data loss that are:
•	 The	area	is	out	of	the	depth-of-field	(too	close	or	too	far	from	the	

scanner). Solution: move the Z axis accordingly and re-scan it. 
•	 The laser intensity is too low to capture the particular color or 

material (usually dark tones). Solution: increase the Laser inten-
sity level and re-scan. 

Other	common	reasons	for	re-scanning	a	specific	area	could	be:	
•	 Strong vibrations caused local distortion of data (vertical lines). 
•	 Area presents too much speckle noise and needs to be re-

scanned with a lower laser intensity.

Re-scanning a specific area

15. Do not press ‘Back’. This will take you to the Home menu and the 
renders will disappear. You will need them for referencing. 
16. Repeat steps 01 to 04. Do not repeat an existing Folder name.

What’s in the session folder

The	session	folder	after	scanning	a	tile	contains	the	following	files:

Session 1.ris 
3D data of the tile in RIS format.

Session 1.xml
Text information about the session.
 
Session 1_00.avi
(...)
Session 1_19.avi
Raw	video	files	of	each	of	the	20	stripes	recorded	by	the	2	cameras.
 
Session 1_depthMap_16b.tiff
3D data of the tile in a depth map format in 16 bits.

Session 1_depthMap_32b.tiff
3D data of the tile in a depth map format in 32 bits.

Session 1_shaded.tiff
3D data of the tile as a render with simulation of relief.

homography_calibration.xml
Homography matrix of this session’s calibration.

system.txt
Text information about the session.
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Re-scanning a specific area

22.	The	specific	area	being	recorded	will	appear	in	both	the	Main	and	
the Navigation window at its relative location within the tile. 
23.	When	the	scanning	process	is	finished,	repeat	steps	11	to	14.

20. Note that the (y) coordinate of the ‘Bottom right corner’ will be 
automatically increased to match a certain ‘Number of stripes’. 
21. Press ‘Update scanning area’. Press ‘Scan’.

Re-scanning a specific area

17. Click ‘Go to origin’.  The head will go to the last session’s origin. 
Do not disconnect the Arduino or you will lose the origin 0,0.
18. Click on the Navigation window and zoom out completely

19.	Select	a	specific	area	to	scan:	you	can	do	this	by	clicking	in	the	
Navigation window and dragging to draw a rectangle or by typing the 
(x, y) coordinates of the ‘Top left corner’ and ‘Bottom right corner’.

<
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<<<
World Map, Anonymous, Silk, Detail
3D scanned in 2011 in Factum Arte, Madrid

5
Troubleshooting

The scanning application was programmed (...) 
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Arduino not connected

If the Arduino board is assigned to a COM port in the laptop different 
to	the	one	which	is	configured	in	the	system_settings	file	an	error	
message (below) will pop up when opening the Scanning Application: 
‘Microcontroller not connected. Check Arduino connection’.

01. Press ‘Accept’. The Scanning Application will open. Press ‘Exit’.
02. Check in the ‘Devices and printers’ menu in the laptop which port 
has been assigned to the Arduino (in the example: COM3) (Fig. 1).
03.	Open	the	system_settings	file	as	a	text	file.	
04. Look for the line ‘<SerialPortName>COM3</SerialPortName>’ 
and match the port number to that assigned by the laptop (Fig. 2).
05. You may have to do this again if you change the laptop.

Fig. 1

Fig. 2

If the Scanning Application is closed without pressing ‘Exit’ button, 
the access to the USB cameras may remain open. If that is the case,  
when you open the Scanning Application again the cameras may not 
be detected. 

01. Open the IDS Camera Manager application that is installed with 
the camera drivers to check the status of the cameras.

02. In order to solve this problem, unplug the cameras from their 
USB ports and plug them again after a few seconds. This should 
make the laptop reset the status of the cameras to this:

Free   Avail.   Type   Cam. ID   Dev. ID   Model  SerNo.
Yes    Yes      USB    1             1             UI-122xLE-M ...
Yes    Yes      USB    2             2             UI-122xLE-M ...

03. If the problem is not solved, unplug cameras again, restart the 
computer and plug cameras back in.

Cameras not connected

Support: factum@factum-arte.com / +34 915 500 978

If you want to watch videos about Troubleshooting please visit: 

www.factum-arte.com
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Trigger not responding

Wifi not available

01. If after pressing the ‘Pulse’ button in the Calibration process noth-
ing appears on the Preview windows it may be because no signal 
has been sent to the trigger of the cameras.
02. This could be caused by a failure in the wiring connections. 
03. In order to solve this, check whether the trigger cables, which 
connect the PCB on top of the scanner head to the cameras, are 
properly connected and/or damaged.
04. Open the Calibration menu and press ‘Pulse’ again.
05. If the problem is not solved check if the ribbon cable which con-
nect the Arduino board with the PCB on top of the scanner head is 
properly connected and/or damaged. 
06. Open the Calibration menu and press ‘Pulse’ again.

01.	Lucida	Scanning	Application	automatically	turns	off	the	Wifi	con-
nectivity of the laptop when you open it and turns it on when you exit.
02. If the Scanning Application is closed without pressing ‘Exit’ button 
the	Wifi	adaptor	will	remain	disconnected.
03. In order to solve this open the Scanning Application again and 
press	‘Exit’.	This	will	re-enable	the	laptop	Wifi	adaptor.

 

Calibration tool incorrectly placed

Incorrect folder path

01. When the name of a session folder already exists, an error will 
pop up: ‘Error while creating project folder. Path to the folder doesn’t 
exist. Check the hard drive is connected properly’.
02. To solve the problem just give a new name to the session folder.
03. Also, when the Folder path does not exist in the computer drive 
the same pop up error window will appear. To solve the problem just 
change the path to an existing one.

01. If after pressing the ‘Pulse’ button in the Calibration process the 
laser stripes in the two Preview windows don’t look as they should 
this	could	be	due	a	badly	fixed	calibration	tool.
02. In order to solve the problem, make sure the positioning dow-
el pin of the calibration assembly is resting straight/true on the top 
side of the vertical carriage. Check also that the back surface of the 
calibration	assembly	is	in	flat	contact	with	the	milled	surface	of	the	
backing board, without touching any bolts from the board (see sec-
tion Calibration).

If you want to watch videos about Troubleshooting please visit: 

www.factum-arte.com

Support: factum@factum-arte.com / +34 915 500 978
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Glossary

Alignment. Last step of the Calibration process that consists of  
overlapping the homographies (dots) from both cameras by hand.

Backing frame. Structural	support	made	from	aluminum	profiles	to	
which three motorized guides and the scanning head are attached. 
As	a		mechanical	set,	it	defines	a	scanning	area	of	480	x	468	mm.	

Beam. Laser beam. The strip of vertical light projected by the red 
laser diode. It has a total length of about 50 mm although the 
effective length captured by the cameras is 26 mm (width of a stripe). 

Calibration. Comparison between measurements - one of known 
magnitude	made	with	one	device	(Lucida’s	calibration	profile)	and	
another measurement made in as similar way as possible with a 
second device (homography of each camera’s view). 

Depth of field. Distance between the nearest and the farthest ob-
jects in a frame that appear acceptably sharp in image. In the case 
of	Lucida,	the	depth	of	field	often	refers	to	the	maximum	relief	that	
can be recorded in a particular scanning session: 25 mm. For deeper 
relief surfaces it is possible to move the scanner along the Z axis. 

Depthmap. One	of	the	output	files	created	automatically	in	a	ses-
sion, consisting on a render of the 3D data which has been captured 
and	processed.	The	format	of	the	Shaded	file	is	a	TIFF.

Exposure. Parameter in the Camera settings that sets the quantity 
of light reaching the camera sensor (default: 180).

File. Session	created	out	of	pre-recorded	video	files,	as	opposed	to	
‘Live’, a session created from live video from the cameras (default).

Glossary

Frames. Each of the 4800 shots captured by each of the 2 video 
cameras in one stripe. The resolution of each frame is 752 x 480 px.

Guides. Each of the linear motion slides that allow the movement of 
the scanner. The scanning head is moved by a system of motorized 
linear guides. The other guides correspond to the X, Y, Z movement.

HDR. High Dynamic Range. Function that captures two frames at 
different exposure levels and combines them to produce an image 
representative of a broader tonal range. 

Head. Scanning head. Assembly of parts that form the main core of 
the Lucida scanner. It includes the laser diode and the two cameras.

Homography. In	the	field	of	computer	vision,	any	two	images	of	the	
same planar surface in space are related by a homography. This is 
used in our Calibration process to correct the camera perspectives.   

Laser. Laser diode. Device that emits light coherently. In Lucida, 
spatial coherency allows the laser to be focused in a tight spot which, 
thanks to a system of lenses, is projected as a linear beam. 

Live. Session created out of live video from the cameras (default), as 
opposed	to	‘File’,	a	session	created	from	pre-recorded	video	files.

Micron. Micrometer or µm. 1/1000 of a millimeter. Lucida 3D scanner 
records at a resolution of 100 microns, that is, 1/10 of a millimeter. 

Noise. When an image is formed by a rough surface which is illumi-
nated by a coherent light such as a laser beam, a speckle pattern is 
observed in the image plane.
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Glossary

Processed data. Digital information that has been transformed from 
one format to another one. The Scanning Application processes the 
raw video footage from the cameras to convert it into 3D information.

Profile. Calibration	profile.	Square	of	23	x	23	mm	formed	by	the	four	
corners	defined	in	the	calibration	tool,	necessary	for	the	Calibration.		

Raw data. Data collected from a source that has not been subjected 
to processing or any other manipulation. Lucida stores raw video as 
one of the most valuable tools for the digital preservation of objects.

Resolution. Resolution is used here to mean the number of points 
per surface unit present in the processed 3D data. In Lucida, depth-
map	files	contain	100	dots	per	cm²	-	254	dpi.	This	is	equivalent	to	
saying that the resolution of the Lucida scanner is 100 µm.

Scanner. Lucida. System developed to obtain contact-free high-res-
olution 3D data from the surface of paintings and low-reliefs objects. 
Lucida projects a thin beam of red light onto the surface of the paint-
ing. As the beam moves across the object the distortions caused by 
the	surface	fluctuation	are	recorded	by	two	video	cameras	positioned	
adjacent on the assembly either side of the laser. The video footage 
is	archived	as	raw	data	as	well	as	processed	as	a	3D	depthmap	file.

Settings. In the Scanning Application, the Settings menu permits the 
control of certain parameters to optimise the scanning session. They 
are divided into System settings and Camera settings. 

Shaded. One	of	the	output	files	created	automatically	in	a	session	
made up of a render of the 3D data which has been captured and 
processed.	The	format	of	the	Shaded	file	is	a	TIFF.	

Stripe. Set of 3D data composed by 2x 4800 video frames along a 
distance of 480 mm. The width of a stripe is 26 mm. A tile of data is 
composed by 20 horizontal stripes with an overlap of 10%.  

Threshold. Parameter of the Camera settings that sets the segmen-
tation from the grayscale image (default: 030).

TIFF. Tagged Image File Format. File format for handling and stor-
ing	images	and	data	within	a	single	file	by	including	the	header	tags	
defining	the	image’s	geometry. 
 
Tile. Set of 3D data composed by 20 stripes of 2x 4800 frames each. 
A tile determines Lucida’s standard scanning area: 480 x 468 mm.

XML. Extensive	Markup	Language.	Markup	language	that	defines	
a set of rules for encoding documents (text) in a format that is both 
human-readable and machine-readable. 

(x, y) coordinates. Position of a point within the tile. The coordinates 
help to determine the position of the scanning head in a session, as 
well as the four corners of a selected area for scanning. 

X axis movement. Placement of the scanner (left-right) along the 
horizontal guides that run parallel to the scanning plane. 

Y axis movement. Placement of the scanner (up-down) along the 
vertical guides that run parallel to the scanning plane.

Z axis movement. Placement of the scanner (forward-backwards) 
along the horizontal guides that run perpendicular to the surface of 
the scanning plane.

Glossary
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Merging Tutorial Example

The following example demonstrates the merging of tile 01B with tile 
01B_RS1 (RS = rescan). 01B is the main tile and 01B_RS1 is the 
rescanned section. 

       
01B_RS1

  
01B

This object has a 

complex topog-

raphy. The area 

in black was out 

of range of the 

laser. 

The rescanned 

area.

Lucida Merging Application 
The Merging Application (Merging App) works with RIS files and 
is used to merge a rescanned section with its corresponding tile. 
It is usually recommended that all rescans are merged with their 
tiles before editing them (Section 2).

Reasons for having rescans of one or more sections in a tile include: 

 a) Local vibrations: these appear as regular patterns of ver-
tical	lines	in	specific	areas.	In	such	a	case,	it	would	not	have	
been necessary to modify the settings of the scanner before 
rescanning the necessary area.

 b) Areas with black data: these result from too low a laser 
intensity. In this case the settings (laser intensity, exposure 
or threshold) would have been changed prior to rescanning. 

 
c)  Areas that are out of range: these occur when the laser 
is either too close or too far from the object. In this case it 
would have been necessary to use the hand wheel to modify 
the distance (z-axis) between the scanner and the object. The 
use of a caliper or a ruler to know the exact distance moved is 
essential, as we will see in the merging tutorial.

For the Merging App to work properly it is important that the rescans 
were done with the same origin as the base tile. This will ensure that 
the rescan is in the correct position in relation to the original tile. It is 
recommended that all rescans comprise some extra area to allow for 
a margin of error when merging (see Lucida Operator manual, p.p. 
31-33).
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3. Load the rescan (e.g. 01B_RS1.ris)

The rescan

4. A message will appear saying: 'Please enter the “z” axis cal-

iper reading in millimetres' (the displacement value). If the dis-
tance of the scanner to the object was not modified, enter 0. If the 
scanner was moved, enter the distance in millimetres. Movement 
away from the object is recognised by the software as a positive 
value and movement closer to the object as a negative value. 

In this case the scanner was moved 10 mm 
away from the object thus the value entered 
is 10. If the scanner was moved 10 mm closer 
to the object, -10 would be entered. 

1. Open the Merging Application

2. Load the main tile RIS file (e.g. 01B.ris)

The main tile
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5.  The window below will appear alongside the final merge fol-
lowing the input of the displacement value. 

If the merge was unsuccesful, press 'x' and restart the merging pro-
cess with a different displacement value. Pay attention to the number 
and whether it is positive or negative. 

If the merge was succesful, press 'a' to save the outcome as a TIFF 
32 bit and press 's'	to	save	it	as	a	RIS	file.	It	is	recommended	that	the	
user do both. 

If a mistake was made during the recording, the re-scanned tile can 
be displaced from the original tile along the x,y-axes. The user will 
notice artifacts and misalignment after trying to merge along the z-axis. 
In this case, the merging is not as straightforward as shown above. Fol-
low the directions on the next page to solve the problem. 

4.1 The result of the merge will appear along with the window shown in 
step 5. The images below illustrate an example of a succesful merge 
using the correct displacement value and an unsuccesful merge using 
an incorrect displacement value. 

01B and 01B_RS1 
succesfully merged 
with the correct 
displacement value.

01B and 01B_RS1 
were not succesfully 
merged in this case be-
cause of an incorrect 
displacement value. 
Note the thick black 
line.
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Editing App
7

To automatically adjust the position of the original tile and the 
rescan use the following commands:

g:  adjusts position in the x,y,z-axes
h:  adjusts position in the x-axis
k:  adjusts position in the z-axis
j:   adjusts position in the y-axis

To manually adjust the position of the original tile and rescan 
use the following commands:

q:  moves second tile down along z-axis by 50 microns
w: moves second tile up along z-axis by 50 microns
e:  moves second tile down along z-axis by 10 microns
r:   moves second tile up along z-axis by 10 microns
u:  moves second tile left along the x-axis (-x) by 50 microns
i: moves second tile right along x-axis (+x) by 50 microns
o:  moves second tile down along y-axis (-y) by 50 microns
p:  moves second tile up along the y-axis (+y) by 50 microns

If the two tiles have been correctly merged, it will be impossible to tell 
where the join is i.e. there will be no artifacts. Once you are happy with 
the result, press 'a' to save the outcome as a TIFF 32 bit and press 
's'	to	save	it	as	a	RIS	file.	

Note:	do	not	save	the	file	until	the	merging	is	complete.	Once	the	file	
has	been	saved,	it	cannot	be	modified.
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The aim of editing is to clean the scan by removing noise, spikes, 
holes, rain and other artefacts using a number of commands and 
tools.	Lucida	produces	four	different	files	(RIS,	TIFF	32bit,	TIFF	8bit,	
AVI).	The	editing	application	works	only	with	the	RIS	files.	

Lucida Editing Application 

1.  Editing Application Interface

Render View Window: 
Displays the full scan. 
Move the cursor to navi-
gate to or select the areas 
that you want to zoom into. 

The Command Window: 
Contains the list of possible 
commands and is where 
the values must be insert-
ed	 for	 the	 different	 filters.	
If you ´lose´ the Command 
Window, press Esc to reac-
tivate it.

The Tool Window: Contains the tools used to 
modify	the	specific	area	in	the	Zoom	View	Window.	

Zoom View Window: 
Displays a zoomed in view of the 
selected area in the Render View 
Window. This window shows the 
area in detail and is a useful tool 
when	 considering	 what	 filters	
are necessary and/or what tools 
should be applied. 
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Press “h” for Denoise, median. 3x3 kernel and threshold (?)
This command is a more general tool to remove noise. It can be 
used for more textured high relief surfaces as its smoothing effect is 
much stronger than that of the Denoise Bilateral Gaussian.

Press “m” for Spikes, median with adjustable kernel and 
threshold. 
This	is	used	to	flatten	surfaces	populated	with	spikes	and	creates	a	
smoothing effect.

Press “l” for Rain Filter Test
This	command	removes	floating	particles	that	occur	due	to	excess	
ambient light, particularily found around the edges of a painting. 

Press “k” to save the current file in its current state

Press “u” to revert to the saved state or undo the last filter 
Right click on a selected area in the Render View Window to view 
the previous state. In order to compare the previous and current 
state, alternate between the left and right click on the mouse. Note: 
you can only do this before saving the current state.

Press “z” to set a light source elevation angle

The following commands change the view in the Render View 
Window:

•	 Press “1” to display zoom, left cabinet view
•	 Press “2” to display zoom, bird's-eye
•	 Press “3” to display zoom, right cabinet view
•	 Press “4” to display zoom, bottom side view

Press “w” to load the 3D data from a RIS file. 

Press “q” to save the 3D data as a RIS file. 
The	RIS	file	is	important	as	it	can	be	opened	by	the	Lucida	Editing	Ap-
plication,	and	therefore	it	can	be	used	to	obtain	the	other	two	TIF	files.	

Press “a” to save the 3D data as 32 bit TIF file. 
The	edited	file	should	be	saved	in	three	formats:	32bit	TIFF	file,	8bit	
TIFF	file,	and	RIS. 

Press “s” to save the shaded render as 2D TIF file. 
The	shaded	render	is	used	as	a	way	to	view	the	file	as	an	image.

Press “x” to exit without saving. 

Press “f” for Gaussian Smoothing. 
This is used to smooth extremely rough surfaces. The possible values 
here range from: sigma: 0.5, kernel: 3x3 to sigma:1.5, kernel:7x7. 0.5 
is the lowest smoothing value and 1.5 is the highest.

Press “g” for Fill Gaps. 
The possible values here range from 1 mm to 10 mm in diameter. The 
value should be chosen according to the size of the holes or 'gaps'. 
For small holes choose a minimum value, but always base your deci-
sion	on	the	largest	hole	possible	to	fill.

Press “n” for Denoise Bilateral Gaussian. 
This	is	mainly	used	for	flat	and	less	textured	surfaces	(like	paintings	
on wood panel). It removes the noise from the surface by slightly 
smoothing it.

2. List of Commands

The	following	commands	apply	filters	to	the	whole	file:
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Below is the recommended order of commands when implementing 
an	editing	session	(these	commands	apply	filters	to	the	whole	file):	

1.	Open	the	file	in	the	Editing	Application

2.	Check	for	holes	and	gaps	in	the	file

3.	Use	the	Fill	Gaps	command	to	fill	the	holes	on	the	surface

4.	Use	the	Rain	Filter	to	remove	the	floating	particles

5.	Check	for	more	holes	or	gaps	and	if	applicable	fill	them			
again (sometimes holes that were not visible before appear  
as	a	result	of	removing	floating	particles).	

6. Use the Spikes Median to remove any spikes if necessary

7. Use the applicable Denoise Median

8. Use the Gaussian Smoothing if necessary

9.	Save	the	file	in	all	3	formats

10. Exit the application 

Tools	can	be	used	to	refine	certain	areas	where	the	commands	did	
not remove or smooth out the imperfections. It is best to apply the 
selected tool right after its corresponding command (ie. 'Rain' tool 
after	'Rain	filter',	'Spikes'	tool	after	'Spikes	Median',	etc.).

4. Planning an editing sessionThe following commands change the view in the Zoom View 
Window:

•	 Press “6” to display stitching, left cabinet view
•	 Press “7” to display stitching, bird's-eye
•	 Press “8” to display stitching, right cabinet view

Tools	are	used	to	manually	modify	specific	selections	in	the	file.	
Select the area to be edited in the Render View Window and directly 
edit it on the Zoom View Window. Tools are secondary to commands 
and should be used only if the command did not work to fulll effect. 
Input the necessary values into the window that apearrs when you 
select the tool. 

Measure: shows the coordinates of each point.

Bump:	creates	curvature	to	specific	areas.

Smooth: smooths out areas with too much noise. 

Clone mean; Clone measure; Clone median: these tools are used 
to replicate an area.

Spikes: smooths the spikes.

Rain: removes	floating	particles	and	is	particularly	used	on	the	edg-
es of the 3D surface. 

Erase: can be used to erase unnecessary data - for example data 
lying outside the area of interest. 

3. List of Tools



Lucida LucidaProcessing Tutorials Processing Tutorials129 130

7 Edit 7 Edit

Press “g” for “Fill Gaps”. Possible values range from 1-10 mm in diameter. 
The value should be chosen depending on the size of the holes. If most holes 
are small, choose a small value, but always take your decision based on the 
largest	hole	to	be	filled.	If	in	doubt	choose	a	mid-range	value	(e.g.	5	mm).

5.2 Press “w”	to	load	the	3D	data	from	a	RIS	file.

5.3	Begin	by	filling	the	gaps	(small	areas	with	no	data,	as	illustrated	
below). 

A gap

5.1 Open the Editing Application

5. Example Editing Session

The command window

The Editing Application
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This value represents the radius from the surface above which parti-
cles will be removed. Possible values range from 0.1 to 0.8. 

You will then be prompted to enter the percentage threshhold value 
as an integer. The threshold represents the frequency (of rain?) - 
for	scans	with	more	floating	particles	use	a	higher	threshold	value.	
The value used is subjective, but 75 is typical. For this example the 
search radius value was 0.5mm with a 60% threshold.

Final result:

5.4		Remove	the	floating	particles	surrounding	the	scan	using	the	
'Rain Filter Test' command. Pay particular attention to the edges by 
using the side view. Select an area in the render view window and 
press “4” to display zoom, bottom side view in order to make the 
floating	particles	visible.

Press “l” for Rain Filter Test and enter the search radius value in mm.
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5.7	The	final	step	involves	saving	the	file	in	three	different	formats:

Press “q”	to	save	the	3D	data	as	a	RIS	file	
Press “a”	to	save	the	3D	data	as	32bits	TIF	file
Press “s”	to	save	the	shaded	render	as	2D	TIF	file

Press “x” to close the Application.

After all tiles have been edited, they are ready for aligning using 
PTGui. 

5.5 Revise the scan for any other holes that were not apparent ear-
lier.	It	is	normal	to	find	more	holes	appearing	as	some	of	them	were	
covered	by	floating	particles	now	removed	by	the	rain	filter.	If	appli-
cable, press “g” for “Fill Gaps”.

5.6 The next step varies for different scans depending on their texture 
and the amount of relief present.

For textured surfaces press: “h” for denoise median 3x3 kernel
For smooth surfaces press: “n” for Denoise Bilateral Gaussian

This example requires the “h” command because the texture is rough. 
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5. A window will pop up saying that no EXIF data was found. 
Do not worry about this message: unlike most DSLRs, the Lucida 
scanner	does	not	attach	EXIF	data	to	its	files.	Close	the	window.	This	
issue will be addressed in the next steps.

6. When the images have loaded, click on the Lens Settings tab.

6.1 Lens type should remain “Rectilinear”. Set the “Focal Length” to 
17.300

6.2 Lens correction parameters should remain 0. This will avoid any 
warping to the images. 

7. On the Panorama Settings tab “projection” should be set to 
“Rectilinear” to keep the lines straight.

Stitching with PTGui
This tutorial describes the process of stitching various edited 
Lucida tiles using PTGui Pro 9.2.0 on Windows 7 

First,	apply	a	transparency	filter	in	Photoshop.	
Then create a shaded panorama in PTGui through the following steps:

1. Open the PTGui software

2. A number of PTGui options must be configured since in the 
default settings the images cannot be stitched successfully.

2.1 On the menu bar open the Options tab (under a tool icon). 

2.2 Go to the Advanced	tab	and	uncheck	“load	16bit	files	as	8bit”.

2.3 On the same tab, check “Allow stitching even if estimated TIF/
PSD size is over 4 Gb” and “Disable SSE / AltiVec acceleration”.

3. On the top right of the software interface, click on the Ad-
vanced tab in order to have access to the advanced options. 

4. Open the tiles to be stitched in PTGui: Project Assistant > “1. 
Load Images”
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9.3 The pair of images as currently displayed in the viewer are too 
small to achieve a good pixel correlation. Adjust the Zoom to around 
50%. Locate any clear visible features, as shown in the example.

9.4 Once features have been located, increase the Zoom level until 
the	chosen	feature	can	be	clearly	identified.	In	the	example	below,	
the Zoom is set at 200%.

9.5 Once the corresponding features have been located, go into the 
left-hand viewport and left-click on the feature 

Note:	it’s	fine	if	you	forget	where	you've	clicked	exactly	because	
PTGui will anchor these 'small windows' for you

8. Click Align images
It is recommended that the user visualize how well the panorama 
was stitched by clicking on the “Panorama editor” icon on the menu 
bar or using the shortcut Control + E.

9. Control points 
PTGui calculates the translations and rotations required for an image 
to	fit	with	its	neighbour	by	using	a	minimum	of	four	'correspondence	
points'. This can be done automatically by the software but to ensure 
accuracy it is better to do it manually. 

Note: the accuracy of the control points should be sub-pixel. To iden-
tify whether this is the case, use the Optimize button (step 15).

9.1 Click on the Control Points tab.

9.2 Select a pair of overlapping images, for example: Image 0 and 
Image 1
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9.8 Repeat this process 4 times for each image pair. 

Note: Once you have set 2 corresponding points manually, PTGui 
will be able to automatically estimate the rest for you.

10. Click on the Optimizer tab and click on “Optimize” in the 
bottom left corner or press F5. 

10.1 The average error should be sub-pixel (i.e. lower than 1). If the 
average error ir higher or equal to 1.00, repeat the placement of the 
control points until the error is lower than 1.00. 

You can manage the control points by clicking Tools > Control Points.

9.6 Within the right-hand viewport, click on the same feature as in the 
left. Guide your eye using the 'small' anchored window.

9.7	The	first	control	point	(CP)	will	now	show	up	on	the	lower	part	of	
the interface. The distance value will be displayed once the project is 
optimized. From this value, it will be possible to determine whether it 
was accurate enough. 



Lucida LucidaProcessing Tutorials Processing Tutorials143 144

8 Stitch 8 Stitch

13.5 Click on “Create Panorama”

14. Open PTGui >> open the stitched project.

15. Go to the Source Images tab. Right click “Load Mask” on each 
image.  Load the corresponding saved mask from Photoshop.

16. Go to Source 
Images and right 
click “Replace” on 
each image to 
replace them with 
the corresponding 

12. Visualising how well the panorama has been stitched is rec-
ommended at this point. Click on the “Panorama editor” icon on 
the menu bar or Control + E. 

The tiles below have been succesfully stitched together:

13. Now go to Create Panorama tab 

13.1 Click on “Set optimum size” and then click on “Maximum size” 
(to make sure there is no loss of any details)

13.2	Set	the	“File	format”	to	“Photoshop	large	file	.psb”

13.3 Now click on “Layers” > “Blended Panorama only”

13.4 Adjust the “Feather” to be close to the sharp side (see next 
page)
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18. Within automatic exposure and colour adjustment click on “Settings”

18.1 Disable “Optimize Vignetting”, Enable full “Optimize exposure” and click 

17. Once all the tiles have been replaced with their corresponding 
depthMap files, click the Exposure/HDR tab.

17.1 Check “Exposure correction” and “Enable HDR stitching” and select 
“True HDR”. 

17.2 Click “Tone map settings” > Disable “Dynamic radius adjustment”, set 
“Radius” to 0.
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21.1 Press Control + E. All 
transformations are linearly 
done. 

22. Go to the Create Panorama tab (see below). 

22.1 Click on “Set optimum size” and then click on “Maximum size (no loss of 
detail)”

22.2	“HDR	file	format”:	should	be	set	to	Photoshop	large	(.psb)

22.3 “Output”: should be set to – HDR – Individual HDR layers (disabled all the 
other options)

22.4 Put “Feather” close to the sharp end of the scale.

19. Within automatic exposure and colour adjustment click on “Optimise 
now”. The Z values of each tile should have been compensated.

20.  At this point, check whether the exposure has been compensated 
correctly is recommended. 

Press Control + E. All transformations are linearly done.

21. Some black straight lines might be visible on the edge of the tiles 
within the Panorama editor. 

The user can now move onto the last step in the processing: ‘Blending’. In 
PTGui	the	file	has	been	aligned	on	the	XY	plane.	On	the	Z	plane,	the	tiles	have	
yet to be aligned and attached. 

In	the	final	Lucida	processing	stage,	the	file	is	aligned	on	the	Z	plane.

23.  Click “Create Panorama”.  
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<<<
3D render of San Vincenzo Ferrer, by Francesco della 
Cossa c. 1473, detail
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In	order	for	the	files	to	be	processed	by	the	Blending	Application,	
they must have been prepared in Adobe Photoshop (CC version or 
higher).

1.1	Open	the	PSD	file	that	contains	the	panorama	with	each	tile	in	
position	as	an	independent	layer.	This	file	must	have	been	previously	
generated with PTGui. 

1.2	Check	that	you	have	the	correct	file	by	selecting	any	layer	and	
going to: Image > Adjustments > Levels and change the values to 
ensure that the relief looks as expected.

 8bit TIFF shaded render

1. Preparation of the files in Photoshop

The final processing step for Lucida data involves blending 
the tiles. Once all the scanned tiles have been aligned in the 
x-y axes (using PTGui or a similar stitching software) this step 
is necessary to ensure a continuous surface between the tiles 
through alignment on the z-axis.

It	is	the	final	step	in	creating	the	3D	files	used	for	rematerialisation	
(routing, 3D printing etc). This tutorial is divided into three sections:

1.	Preparation	of	the	files	in	Photoshop
2. Input into Lucida Blending Application
3.	Preparation	of	the	file	for	prototyping	and	other	processes

The example used below comprises 6 tiles. It serves to illustrate the 
required steps but should be used only as a guideline as each project 
will differ.  

Lucida Blending Application

  32 bit depthmap
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Note: When ´Resample´ is off, changing the resolution will change 
the width/height dimensions accordingly and not the overall ´Image 
Size´.

1.6 Image > Mode > Grayscale > Merge layers?... > Don’t Merge

1.7 Edit > Colour Settings: Working Spaces: Gray: Gray Gamma 2.2 
> OK

1.8	Edit	>	Assign	Profile	>	Profile:	Linear	Grayscale	Profile	>	OK	

1.9 Change the canvas size: Image > Canvas Size > New Size: 
Width: 17000 / Height: 9602 px

Note: If	the	file	that	has	been	stitched	is	larger	than	the	new	size	
listed	above,	the	file	must	be	split	into	sections.	With	the	current	
Blending	App	this	is	the	maximum	file	size.

1.4 Check that 32 Bits/Channel is on: Image > Mode > 32 Bits

1.5 Adjust the resolution: Image > Image Size > Resample: Off (un-
checked) > Resolution: 254 pixels/inch

1.3 Delete all layer masks that may have been created in PTGui. 
Right click on Layer Mask > Delete Layer Mask

Layer mask
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1.12 Reduce the opacity of the layers (e.g. 50%) to illustrate the overlap 
between	tiles.	The	standard	overlap	between	tiles	should	be	≈	50	mm.	

1.13 Check that the vertical and horizontal guides are in millimeters 
by right clicking on them.

  
1A      1B       1C

2A      2B        2C

1.10 Create a 100% black or white background layer in order to make 
the tile overlaps more visible.
Layer > New > Name: Background/ Colour: Black > OK. 
With the new Background layer selected, use the Rectangular Marque 
Tool (see below) and outline the whole canvas. Right click > Fill: Black. 
Drag Background Layer to the bottom of the Layer Panel.

Note: The eye 

button on the left 

of each layer will 

show/hide each 

layer making its 

location clear on 

the canvas.

1.11 Change the name of each layer to its corresponding tile name 
e.g. 1A (or 01A), 1B, 1C, 2A, 2B, 2B_RS1 (RS = re-scan) etc. The 
horizontal dimension (rows) is marked with letters and the vertical 
(columns) with numbers.
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1.5	After	marking	all	overlapped	areas	within	the	correct	range	(≥	10	mm	
and	≤	25	mm),	use	the	Rectangular	Marquee	Tool	select	an	area	that	
encompasses the excess overlap. Then delete the excess area from the 
selection adjacent to the tile. 

Each tile should be treated separately, starting with the vertical overlap. 

Delete from tiles 1A and 2B 

Selected area

1.14 Drag the guides from their corresponding horizontal and vertical 
axes and place them onto the overlapped area to outline a space 
that	is	≥	10	mm	and	≤	25	mm.	It	is	best	to	zoom	in	at	this	point	to	en-
sure accuracy and check that the overlapped area does not include 
any holes as they may be problematic later on (see p. 5).

Zooming into 

the overlapping 

area to check for 

holes.
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Before 

After

Before   

1.16 Repeat this step for the horizontal overlapped tiles. 

The	images	on	the	next	page	illustrate	the	final	product	following	the	
removal of excess overlap.

After  
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Overlap

Before

After

1.17 In order for the Blending App to work correctly, the borders 
of the overlapped tiles must be evened out. With the guides still in 
place, zoom in at the edge of an overlapped area and use the Lasso 
or Polygonal Lasso Tool to remove any uneven edges. Do this for all 
vertical and horizontal overlapped tiles.

In order to preserve as much data as possible follow the contour of 
the overlapped border. 

With the Lasso tools, enter the area at an angle (see next page) to 
ensure a smooth transition between tiles. Delete the selected area 
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Specify under Byte Order that it is for IBM PC. 

After	all	tiles	have	been	saved,	the	files	can	now	be	blended	in	the	
Lucida Blending Application. 

1.21	Save	the	Photoshop	file	in	case	you	need	to	go	back	and	make	
corrections.

1. 20 File > Save As… > Save as the corresponding tile name (eg. 
1A)	and	as	a	RAW	file.

1.18 Change the opacity of the layers back to 100% and remove 
guides: View > Clear Guides.

1.19	Save	one	RAW	file	for	each	independent	tile.	To	do	this,	turn	off	
all layers except the tile to be saved and the background layer. Your 
Photoshop	version	must	be	able	to	save	32	bit	RAW	files	(Photoshop	
CC or higher). 
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Note: the overlap amount falls comfortably within the 10-25 mm range 
(in this example: 13.6 mm). If the value is out of range it means there 
is	a	problem	with	the	preparation	of	the	files	in	Photoshop.	If	this	is	the	
case,	go	back	to	the	Photoshop	file	and	review.

2.4 Press any key except 's' and 'x' and load the last horizontal tile for 
row 1, 1C.

2.5 When all horizontal tiles have been blended for this row press 's' 
and save as '1.raw'.	The	saved	file	should	be	in	RAW	format,	although	
this will not be an option on the computer. This must be inputted man-
ually by adding ´File_Name.raw´.

2.6 Repeat this process for row 2 (tiles 2A, 2B and 2C) and save the 
row as '2.raw'.

2.1 Start the Horizontal Blending Application: BlendingApp64bits.exe

2.2	The	message	'Please	load	the	first	file'	will	appear.	Navigate	to	
the correct folder and load tile1A.

2.3 When prompted load tile 1B. 

The Lucida Blending Application blends the tiles by aligning the 
z-axis.	Usually,	the	tiles	are	first	blended	horizontally	in	terms	of	each	
row. The results are then blended vertically to create a complete 3D 
file.	The	order	of	blending	may	vary	depending	on	the	nature	of	the	
project.

Step 1: Horizontal Blending

Step 2: Vertical Blending

2. Input into Lucida Blending Application
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2.11 Use the levels to check that there are no mistakes in blending. Go 
to Image > Adjustments > Levels. 

Move the black arrow on the left (under Input Levels) closer to the mid-
dle arrow and notice the change in levels of the image. By doing this 
you	will	be	able	to	see	the	relief	of	the	file	(see	next	page).	

Again, note that the overlap is between 10 and 25 mm. This means 
the	files	have	been	successfully	blended.	

2.9 Press 's'and be sure to add '.raw'	to	the	end	of	the	file	name.	

2.10	Open	the	final	RAW	file	in	Photoshop.	Note	that	Photoshop	will	
not	recognise	the	file	in	this	format.	In	order	to	open	the	file,	alter	the	
following parameters in the Photoshop Raw Options tab (illustrated on 
the next page): 

Width: 17000 pixels
Height: 9602 pixels
Depth: 32 bits
Byte Order: IBM PC
> OK

Specified	image	is	smaller	than	file,	open	
anyway? > OK

2.7 Blend the two rows using the Vertical Blending Application: 
23000Blend2Rows.exe 

2.8 Open the Application and load '1.raw' into the App. When asked, 
load '2.raw'.
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2.13 Highlight the adjustment shadow input level number (box on far 
left) and zoom in close to the image. Use the mouse wheel to adjust 
the numerical value in the adjustment shadow input level box. Simul-
taneously adjust the levels and navigate across the image (especially 
the borders) in order to view any discrepancies.
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2.14 When happy with the blending, change the resolution. The 
Blending	App	changes	the	resolution	of	the	file	to	72	ppi	and	it	must	
be changed back to 254 ppi before proceeding:

Image > Image Size > Resample: Off (unchecked) > 
Resolution: 254 pixels/inch 

2.15	Save	the	file	as:	´[name	of	work]_3D_254ppi_32bit	´.

2.16 Go to Image > Mode > Change to 16 bit. In the HDR Toning 
Window change the following parameters:

Preset: Custom
Method: Exposure and Gamma
> OK

 

The image above shows that there was a problem with the blending 
procedure, indicated by the rigid line. When checking for discrepan-
cies be sure to notice anything that seems out of character with the 
texture of the surface you are scanning e.g. something too uniform 
or straight, particularily along the edges. If problems are found, re-
turn	 to	 the	preparation	of	 the	files	 in	Photoshop	and	check	 that	 the	
overlapped borders have been evened out and that all the outlined 
parameters are met.
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Important: keep	 these	figures	as	 they	will	 be	needed	 to	 return	 the	
images to their original size in 4.6. 

3.4 In 'Image size' change the dimension units to percent and insert 
the	new	percentage.	Note	the	new	dimensions	of	the	file.

The overlap between the two tiles will increase to meet the acceptable 
range in the blending application. 

3.5 Continue the procedure as stated above – in the following order:

•	 Trim overlap
•	 Adjust overlap edges
•	 Name tiles
•	 Change canvas size to (17000x9602) 
•	 Save tiles separately in raw format 
•	 Input the tiles into the blending application.
•	 Blend tiles
•	 Check result in photoshop

3.6	Open	 the	 resultant	 raw	 file	 from	 the	 blending	 application	 on	 to	
Photoshop and return the image to its original size.

Go to Image >> Canvas size. Change the canvas size. 

3.7	Place	the	newly	blended	tile	in	its	exact	location	within	the	main	file	
and	continue	the	file	preparation	process.	Always	treat	the	outcome	of	

3. Overlap less than the acceptable range

Errors can can occur during the recording phase that result in a miscal-
culation of the required overlap. This often happens when the surface 
being scanned is very large and the scanner frame has to be moved 
between scanning sessions - the distance between tiles might be incor-
rectly calulated.

In such cases, the blending application will automatically reject a tile 
and will display the message “Overlap less than 10 mm” before ter-
minating.	This	problem	must	be	solved	in	Photoshop	before	the	file	is	
sent to the blending application.

3.1 Open the two tiles that share an overlap of less than 10mm in a 
new	Photoshop	file.

3.2 Measure the exact overlap between tiles to work out the percent-
age by which you need to enlarge the image. 

For example, if the overlap is 8mm and we want to change it to 11mm, 
perform the following calculation: 

 8 : 11
 100 :x
 x = (100 * 11) / 8 = 137.5 % 

This	means	the	file	has	to	be	enlarged	by	37.5.

3.3 Go to Image >> Image size and take note of the image size – width 
and height. 
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1.5 In the dialogue window,choose ‘black’ from the dropdown menu to 
fill	the	pixels	in	black.	

1.6 Repeat steps 1.2-1.4 but choose ‘white’ from the dropdown menu 
to	fill	pixels	in	white.	

1.7 Zoom out. Zoom into the corner diagonally opposite. Repeat steps 
1.2-1.6. 
 
At the end of steps 1.2-1, you will have marked two corners. These 
black and white marked pixels are used by ArtCAM to establish the 
depth	range	of	the	file.

If	at	 this	point	you	were	working	on	the	RAW	file	then	proceed	with	
step 1.8 – otherwise move onto step 1.11.

1.8 Select Image -> Mode -> 16bits/channel

This section explains how to import Lucida reliefs into ArtCAM, an Au-
todesk	software	that	can	be	used	to	edit	3D	files	in	preparation	for	CNC	
milling.  This tutorial has been written for Artcam 2012 Pro and Photo-
shop CS6, but similar tools will be available in other versions. 

1.1	Prepare	the	file	in	Photoshop.	The	file	must	be	16-bit TIFF – this 
is the resolution used by ArtCAM.

Note: in order to avoid height distortion when working with Lucida 
reliefs in Photoshop, load the “Lucida_depthMaps_linearity.csf” colour 
profile.	This	colour	profile	is	provided	with	the	Lucida	software	distri-
bution.	To	load	the	colour	profile:

•	 Select Edit -> Colour Adjustment
•	 A dialogue window will appear
•	 Select “Load”
•	 Find	the	Lucida_depthMaps_linearity.csf	file
•	 Click Ok

Now,	the	linear	colour	profile	is	selected	by	default.

1.2	Zoom	into	one	corner	of	the	file	until	the	pixels	are	visible.	

1.3 With the rectangular selection tool select a small number of pixels

1.4 Right-click inside the selected area and press Fill.

Importing Lucida reliefs into ArtCAM
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1.11 Open the Artcam software

1.12 Select File->New->From Image File

1.14 A dialogue window with the dimensions of the relief will appear. 
Set	the	“Height	in	Z”	field	to	500mm.	

ArtCAM will measure the different depths of the grey scale image 
using the 500mm scale: pure black will mark the lowermost and pure 
white the uppermost points in the scale.

1.15		Press	OK	to	finish	importing	the	file

1.9 The HDR Toning window will appear. On this window select:

Method -> Exposure and Gamma with the following parameters:

Exposure = 0
Gamma = 1

1.10	Save	the	file	as	a	TIFF	file,	
selecting the following:
•	 No compression
•	 Interleaved px order
•	 IBM PC byte order
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2. Run the file BestFitPlane.exe

3. The program will bring up a dialog window asking the user to 
select the relief file. It has to be a 32 bit Tif image containing the 
relief depthmap.

4. Once the file has been selected selected and opened, the user 
will see a preview window showing the rotated relief. 

5. Press “a” to process and save the image. The rotated relief is 
saved as a 32 bit Tif image.

A seemingly planar surface captured with Lucida may present some 
degree of tilt due to the fact that the scanned surface and the scanner 
mast can never be completely parallel. Sometimes, it can be inter-
esting to correct this tilt: for example, in order to save material when 
rematerializing.

This section describes how to automatically rotate a relief generated 
with Lucida to correct the tilt. 

For doing this a script has been implemented to performs the follow-
ing actions:

1. Calculates the mean plane of the relief. This is done using a best 
fit	plane	algorithm	as	described	in	http://www.geometrictools.
com/Documentation/LeastSquaresFitting.pdf

2. Calculates the angles of the mean plane to the horizontal plane.
3. Knowing the angles, then applies a rotation to the whole relief to 

render it horizontal.

Note that currently this script works only with planar or symmetrical 
reliefs. The script does not work well with irregular reliefs made up of 
several areas of different heights.

1. Install the script
Download and uncompress the folder BestFitPlane. Inside it is the 
executable program that runs the script.

In order to run the BestFitPlane program you need to install the Visu-
al C++ Redistributable package in your computer
http://www.microsoft.com/en-us/download/details.aspx?id=14632

Rotating Lucida reliefs
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Detail from colur data of the Selden Map
(Bodleian Library, Oxford) 
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10. Adjust mode to: RGB - 16 bit

11. Convert the profile to Prophoto RGB: Edit › Convert Profile › 
Prophoto RGB › Ok

12. The 3D file can now accept the colour layer. Drag the colour 
layer onto the 3D layer. 

The	final	steps	are	carried	out	with	both	the	colour	and	3D	files...

13. Record all the actions you perform in the following steps.

14. First, fit the two files onto each other as well as possible 
without distorting the files.  

15. Then enter the Free Transformation mode: Ctrl+T
•	 First resize
•	 Then right click distort
•	 Finally right click Warp

16. After adjusting the image as well as possible, check for local 
problems and fix them by warping the problematic area using 
the Local warp tool. 

Start	by	working	on	the	3D	file...	

1. Open 3D shaded file on Photoshop

2. Change to Gray Scale: Image › Mode › Gray Scale

3. Assign Profile to Gray Gamma 2.2: Edit › Assign Profile › Gray 
Gamma 2.2

4. Change the resolution from 300dpi to 254 dpi. Allow the file to 
re-siz eautomatically.

5. Take note of the new size of the file: this will be the 'official 
size'.

Now	start	working	on	the	colour	file...

6. Open Colour file on Photoshop

7. Check that the dimensions of the file are the same as the 'of-
ficial size' determined in Step 5. If they are not, change them to 
the 'official size' in Image › Image size

8. Take note of the resolution (it should normally be between 
500 - 600 dpi).

Again,	work	on	the	3D	file...

9. Set the resolution on the 3D file to be the resolution read on 
the Colour file. Do not change the size of the 3D image. This can 
be done by checking the Resample box which unties the rela-
tionship between the size and the resolution.

Registering colour information onto Lucida reliefs
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will be lost and having a lower final resolution makes sense. In this 
point use common sense and experience.
•	 Click "OK" 
•	 Select all and copy
•	 Go	to	the	Color	file
•	 Paste the 3D rendering 
It is important to follow the order as presented and not paste the color 
on the 3D for the color profile to be preserved, thus the color file is kept 
and respected.
•	 Read jdpi by going into menu Image>Image Size
•	 Uncheck "resample"
•	 Set	resolution	to	the	resolution	chosen	for	the	3D	file
•	 The next steps outline the registration process...
•	 Register	the	files	in	one	transformation
It is very   important to do the registration in one and only one transfor-
mation as several would damage the image quality significantly.
•	 Stay at 16 bits when doing the registration
•	 Leave	the	3D	layer	at	bottom	of	file
•	 Just above create an adjustment Levels layer and compress the 

histogram
This increases contrast and makes the registration process easier. 
Note that adjustment layer is nondestructive.
•	 Change the opacity of Color Layer to be above 50%
The value may differ depending upon the file that one is working on. Try 
to maintain a suitable for the particular file.
•	 Select color layer >> layers palette
•	 Deselect all - Menu select>Deselect
•	 Start transform by Menu Edit>Free Transform
•	 Scale the color layer approximately to the 3D layer
•	 In the status bar of the tool, just under the main bar of Photoshop 

Window there is a menu "Interpolation". This is where the type of 
interpolation for the whole transform is chosen.

•	 Choosing "bicubic sharper" will sharpen a bit when applying the 
transform, but don't apply the transform yet.

•	 Right-click in the transform box and choose

The multilayered viewers created at Factum can integrate different 
types of data into one easy-to-use Flash-powered internet browsers. 
It's possible to integrate Lucida 3D data and high-resolution colour but 
also register, for example, older images or infrared data onto the 3D 
data. These browsers can be of great use for researchers who want to 
compare various dataset of one object or painting. 

Creating multilayered viewers

•	 Get	the	color	and	3D	rendering	file
•	 Open	the	3D	rendering	file	in	Photoshop	
•	 Rotate	the	file	90°
•	 (That	 allocates	 the	 file	 into	 the	orientation	 it	 is	 supposed	 to	 be	

viewed in.)
•	 Check its real size by
•	 Menu Image>Image Size
•	 Uncheck "resample"
•	 Set resolution to 254dpi (0.1mm per pixel)
•	 Click "OK"
•	 Open	the	Color	file
•	 Check its real size and set units to cm or mm
•	 Measure a known distance
•	 Open Image Size
•	 Change dpi with resampling unchecked
•	 New dpi= current dpi*(current measure/real distance)
•	 Measure again the know distance 
•	 Make sure that the value is correct
•	 Note the new dpi value
•	 Go	back	to	the	rendered	3D	file
•	 Menu Image>Image Size…
•	 Check "resample", choose bicubic
•	 Set the resolution value below the value noted above 
For example if you have 460dpi for the color file, choose 400dpi. The 
change is necessary as during the registration process a level of detail 
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This is your Archive registered file
•	 Apply	some	Smart	Sharpen	or	Unsharp	Mask	filters	as	needed
Usually a value like 0.8 pixels 80-100% should be reasonable and conser-
vative enough.
•	 Bring	16bits	file	down	to	8bits
•	 Convert	profile	to	RGB
•	 Save under a new name that contains "8bits RGB"
•	 This	file	is	for	the	viewers

Creating individual files for layers
These files are used later for creating tiles by KRPano

•	 Open	the	file	created	above	to	be	used	for	viewers
•	 Create an adjustment layer "Solid color" >> black
•	 Put the adjustment layer at very bottom
The adjustment layer is created due to the fact that the Color Layer was dis-
torted to fit 3D and its edges might have come in and create transparency on 
the edges that we want black.
•	 Hide 3D layer
•	 Make sure Color Layer >> 100% opacity
•	 Save as a Copy
•	 Uncheck "layers"
Unchecking “layers” will flatten the file for the save.
•	 Name	the	file:	color.psb	or	color.psd	or	color.tif
•	 After Saving hide the color layer
•	 Show 3D layer
•	 Make sure 3D Layer >> 100% opacity
•	 Add an “adjustment Levels” layer
The adjustment Levels layer aims to slightly contrast the 3D layer for the 
viewer
•	 Save as a Copy; Uncheck "layers"
Unchecking “layers” will flatten the file for the save.
•	 Name	the	file:	3D.psb	or	3D.psd	or	3D.tif
•	 Keep	this	file	in	the	color	profile
•	 After Saving: 
•	 Show all layers
•	 Set color layer opacity >> 30-50%
•	 Adjust the adjustment levels layer to add contrast to the 3D layer

•	 "Distort"
•	 Adjust the 4 corners - one after the other
•	 Make another round, to register the corners; at this point only cor-

ners count. Now all 4 corners are well registered and checked.
•	 Right-click again in box and choose "Warp"
•	 Be careful and systematic
•	 Make only small movements
•	 Start with center of every edge between the corners
•	 Register the sections
•	 Recheck the corners in the process
•	 Register the center of the painting
•	 Check again center of edges and corners; check center
•	 Keep checking and registering the layers
It is important to do this process repetitively because every move may 
slightly unregister other parts, so when going through the process re-
peatedly the end result of the file is more precise. Also the registration 
of the overall file is gets closer to the original and the percentage error 
is reduced to minimal.
•	 Check	the	file	one	final	time
•	 Validate the whole transform (Free, Distort, Warp)
•	 Press the enter key on the keyboard.
It might take some time for the transform to reach completion.
•	 Change the color layer opacity to 100%
•	 Go	around	the	file	at	25-50%	zoom
•	 Keep switching color layer on and off – checking that the registra-

tion is ok 
If the transformation is faulty in the slightest, revert it in history window 
to the step before the transformation and the entire transformation pro-
cess must be repeated.
•	 Delete the adjustment layer
•	 Make contrast in the 3D layer, keeping only 3D and color layers in the 

file.
•	 Crop	the	file	to	a	suitable	-	the	3D	layer	is	the	limit
•	 Save	the	file	under	a	new	name,	with
•	 "Name_16bits" or "Name_8bits"
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•	 Go to the "License Setupo" tab
•	 Check	that	the	fields	for	license	are	filled	with
•	 "Registered to: greg@factum-arte.com 
•	 Branding	free	license	is	not	filled
•	 Go to "Encryption-Tool" tab
•	 Uncheck all boxes at bottom of window
•	 For each folder produced above:
•	 Click "Add Folder"
•	 Choose the folder called "*.tiles"
•	 The tiles in that folder are loaded in the File list in the window
•	 Click "Encrypt Files"
•	 Repeat with each of the viewers folders to upload
•	 Close the encryption application

Uploading the viewers to the server

•	 You	will	need	to	create	a	tar	archive	file	to	upload	because	uploading	tiles	
as folders like this can take a very long time. Place all your viewers into 
a	single	folder	called	"viewers".	Make	sure	the	large	image	files	used	for

•	 producing the viewers are out as we don't want them uploaded.
•	 Open Terminal in OSX and type "cd "
Include a space after cd. - cd meaning "change directory"
•	 Drag and drop the folder containing the folder containing your viewers 

(called "viewers")
• You will find the folder in the Finder onto the terminal window.
•	 The Terminal window active, press enter or return
We just told the terminal to change root director so operations will happen in 
that directory (folder).
•	 Create	the	archive	tar	file	with	a	name	related	to	the	viewer	"virgin.tar",	no	

space or spacial characters in the name. Now type in the terminal: "tar cvf 
virgin.tar viewers"

That means: create a tar file called virgin.tar, of the folder called viewers that 
sits within the cd we just did before.
•	 Use an ftp client (Cyperduck on Mac OS: http://cyberduck.ch):
•	 Open a connection to: ftp.factum-arte.org with username: "factumar-vie" 

password: "xxxxxxxxxx"
•	 When	connection	is	established,	upload	the	tar	file	in	that	ftp.

This makes the 3D layer underneath more visible and displays the present 
information clearly. 
•	 Save as a Copy
Once the composite Color-3D file looks as you want it to for the"50%" layer 
in the viewer.
•	 Uncheck "layers"
Unchecking “layers” will flatten the file for the save.
•	 Name	the	file:	color3D50pc.psb	or
•	 color3D50pc.psd or color3D50pc.tif
Just "color3D50pc" for the name is fine
•	 Close	your	file	WITHOUT	SAVING
Only save if you are sure you didn't flatten anything and want to keep added 
information, such as the adjustment layers.

Creating the individual viewers with krpano

•	 Download KRPano.
•	 http://www.highres.factum-arte.org/downloads/
•	 Unzip the KrPano folder
•	 Use	only	the	file	by	the	name	"MAKE	PANO
•	 (MULTIRES) droplet.app"
•	 (However, keep all together as it is.)
•	 Create 3 folders >> "3D" "color" and "color3D50pc"
•	 Place	the	corresponding	files	created	above	into	their	respective	folders
•	 One	after	the	other,	drag	and	drop	these	files	onto
•	 "MAKE PANO (MULTIRES) droplet.app"
•	 The	app	opened	a	Terminal	Window	that	will	ask	you	if	the	file	is	a	flat	

partial panorama, that should be the choice "1". 
Then the terminal window will show the progress as tiles and other files are 
created in the folder where the dropped file was.
•	 Do the same process for all 3 image
•	 Now you have the three folders check that the above steps have been 

conducted	correctly	by	launching	the	html	file	within	each	folder	
•	 Encrypt the jpeg tiles
• This is done so that the images cannot be accessed without the licensed 

viewer.
•	 Open the "krpano Protect Tool.app": "krpano Protect Tool.app" is found 

in the KRPano folder.
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1.1 Star by mounting the laser diode and temperature sensor onto the 
copper plate. Make sure that the pins of both components correspond to 
the positions of the holes on the PCB board.

Components:

PCB Board   Temperature sensor
Laser diode   Copper Plate
Plain white paper  Tin (0.5mm)
4 M1.6x3 screws  6 pin male header strip

Tools:

Solder Allen Key

1. Mounting the laser board

This tutorial is designed as a reminder for someone who has already 
assembled several heads with the help of one of Factum's operators. It 
takes the user through the steps required with the aid of pictures. 

Before placing the temp. sensor onto 
the copper plate, cut 3 thin, short 
strips of plain white paper (approxi-
mately 2mm wide). Then add glue to 
one edge of each strip and glue them 
to the bottom of the temperature sen-
sor groove. The paper forms a bas-
ket-like structure which insulates the 
temperature sensor from the copper 
plate. Now you are ready to attach the 
temperature sensor. Once it has been 
attached, cut off the extra paper. 

1.2 The copper plate be joined to the PCB 
board. Place the PCB board onto the cop-
per plate  the three laser diode pins and 
3 temperature sensor pins through their 
corresponding holes onto the PCB board. 
Solder them onto the PCB board using tin 
(0.5mm) and a solder.

1.3 To secure the PCB board onto the cop-
per plate use 4 (M1.6x3) screws to attach 
its four corners.

1.4 Now, take the 6-pin male header strip 
and press the plastic part to one side of the 
pins, in order to make them longer so that 
they can be attached properly to the trigger 
board.

1.5 Finally, attach the 6-pin male header 
strip to the top of the PCB board through 
its six holds and solder it to the board.
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2. Mounting the laser module

Components:

Laser Structure   Convex Lens
Convex Lens Holder  Polarizing Plate
Aspherical Lens   Aspherical Lens Holder
Araldite glue   2 M2x5 screws

Tools:

Allen Key   Cutter
Plastic Tube

2.1 Place both the aspherical and 
convex lenses each into their cor-
responding lens holder. Note that 
the curved part of the convex lens 
must have an upward orientation

2.2 To secure both lenses in place, 
carefully apply Araldite glue on to the 
edges of the lenses using a thin tool 
– for example, a pin. For the aspher-
ical lens, the glue is applied onto 
the sides through two holes on the 
lens holder; but for the convex lens 
the glue is added from the top in the 
area between the edges of the lens 
and the edges of the lens holder.

2.3 Once the glue is dry, position the 
polarising plate on top of the convex 
lens holder. 

2.4 Start by positioning the convex 
lens holder in place, while main-
taining a vertical orientation for the 
polarising plate – the same orienta-
tion through which the laser beam 
will be projected onto the surface 
of the scanned object. Push the 
lens holder into the hole of the la-
ser structure using a plastic tube of 
the same size as the lens holder.

Now the lens holders can be joined onto the laser structure...

2.5 Scrape off any extra dry glue 
from the aspherical lens-holder – 
so	that	it	can	fit	easily	–	then	push
it behind the convex lens-holder.

Note: It is very important to keep 
the lenses clean at all times using 
a cleaning air pump
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3. Assembling the cameras

Components:

Camera	Bar		 	 Isolator	film
Camera Board   Lens
Lens Holder   Hexagonal star screwdriver
2 M3x16 screws  4 M1.6x6 screws
4 plastic washers M2x3

Tools:

Lens Handling tool  Cleaning Air Pump
Allen Key

3.1 Make sure that the two 
lens-holders are facing one an-
other as they are symmetrical. 
Positioning them correctly before 
assembly prevents errors such as 
inserting the cameras in the wrong 
orientation (see image). 

3.2 Then, screw the lenses onto 
the lens-holders. The image shows 
the camera lens fastened onto the 
lens holder. 

3.3 Place the lens holder in a 
well-supported position.

3.4	 Place	 the	 isolator	 film	 on	 top	
of the lens – this is done so that 
there is no contact between the 
metal body of the lens-holder and 
the camera.

3.5 Use the hexagonal-star screw-
driver to unscrew the four interior 
screws from the camera board that 
attach it to its protection.

3.6 Quickly and carefully remove the plastic cover from the camera 
board	and	place	it	on	the	isolator	film.	This procedure should happen 
quickly because leaving the camera into the light, air and dust weakens 
its sensors and could damage it. 

3.7 Prepare four M1.6x6 screws 
and M2x3 washers. Place the 
washer in the correct position onto 
the board. Start adding the screws 
in a diagonal order for stability pur-
poses.	Finally,	fix	the	camera	hold-
ers to the camera bar using three 
Mx16 screws.

Note: The plastic washers are relatively longer than their screws thus 
it is necessary to cut the extra material and shorten the plastic washers



Lucida Lucida208 209Component assembly Component assembly

14 Assembling the head 14 Assembling the head

4. Assembling the structure

Components:

Camera Bar   Connection Plate
Laser Module   Cable-tray Bracket
Internal Clip   Protection Plate
6 M2 washers   6 (M2x10) screws
4 (M4x12) screws  2 (M3x5) screws
2 (M1.6x3) screws  1 (M2x5) screw
2 (M2x5) Grub screws

Tools:

Allen Key   Hammer

4.1 To begin with, attach the camera 
bar to the connection plate using a set 
of 4 (M4x12) screws and two dowel 
pins. 

4.2	Now	fix	the	laser	module	onto	the	
connection plate using 6 (M2x10) 
screws and 6 M2 washers. 

4.3 Then, attach the cable-tray bracket to the side of the laser module 
using 2 (M3x5) screws. At this point, the scanner-head assembly is 
almost complete. Attach the internal clip to the connection plate using 
an (M2x5) screw.

4.4 Before proceeding any fur-
ther, connect the Arduino board 
to the scanner head using a 
flatribbon	cable	and	mount	 the	
scanner head onto its stand.

4.5 The laser beam must be adjusted to ensure that it can project in 
a vertical, centred line. Install the scanning head onto a horizontally 
placed backing frame – which will house the Perspex tool for laser

4.6 Place the LBR tool onto the horizontal guide beneath the scanner 
head and tighten it. Now with the same plastic tube that was used to 
insert the lens-holders, adjust the orientation of the convex lens-hold-
er, making the slit on the polarizing plate completely vertical. 

4.7 After adjusting the laser beam, tighten the two screws place the 
protection	plate	on	 the	Laser	structure	and	fix	 it	with	 two	 (M1.6x3)	
screws.

The scanner head is now ready for testing and laser alignment.
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5. Configuring the laser

Components:

2 (M2x5) Grub screws

Tools:

Allen Key
Laser Adjustment tool
Laser Lens Adjusting Plastic tube

5.1 To start, loosen the two grub screws at the side of the laser stru-
ture and place the laser adjustment tool on the horizontal guide. This 
tool is made of transparent acrylic; it has a grid of vertical engraves 
onto which the laser is projected. 

There	are	two	main	steps	for	adjusting	the	laser,	the	first	of	which	is	to	
make the laser line completely vertical.

5.2 Look at the laser on this grid: the laser lens adjusting plastic tube 
should be used to lightly rotate the convex lens until it reaches a com-
pletely vertical position. Now tighten the two grub screws.

The second step involves centring the laser beam projection onto the 
laser adjustment tool.

5.3 In order to centre the la-
ser beam, untighten the two 
M2x5 screws at the back of 
the laser control board and 
shift the board slightly, un-
til the laser beam projection 
reaches the centre of the la-
ser adjustment

6. Configuring and adjusting the cameras

Components:

2 (M2x5) Grub screws

Tools:

Allen Key

6.1 Access the IDS Camera Man-
ager software. This enables the 
user to change the ID number 
corresponding to the camera and 
allows the software to read it. 

6.2 On IDS Camera Manager soft-
ware, open the Camera Informa-
tion tab and change the Camera 
ID to the necessary port number, 
For example Cam1 – Port 1 and 
Cam2 – Port 2. 
 
You can check the port number by 
unplugging one of the cameras. 
Then check the Camera View on 
the Lucida Application and the re-
sults will display immediately.
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6.3 After mounting the scanner head onto the horizontal guide and 
checking the necessary connections, open the Lucida Application. In 
the settings tab, check the camera window: start by identifying Camera 
A and Camera B. 

Once	identified,	carry	out	the	following	steps	with	Cameras	A	and	B:	
•	 Adjust the focus of the lens by screwing it in/out: loosen the grub 

screw at the side of each Camera holder. Remember to re-tighten 
the grub screws once the focus is adjusted.

•	 Adjust the rotation angle by rotating the lens holder.
•	 Adjust the view-window by unscrewing the four screws at the back 

of the camera board (just enough to allow free motion). Shifting the 
camera board horizontally will appear on the live view window as 
vertical motion and vice versa.

7. Troubleshooting

What if the scanner head is connected to the computer but the 

laser is not appearing?

There could be two problems: either the ribbon-cable connecting the 
trigger board to the Arduino or the USB cable connecting the Ardui-
no to the computer are malfunctioning. Start by checking the connec-
tion of the two cables. If they are well connected and do not show any 
problems then check the trigger board and Arduino board connection 
through	the	shielded	flat	ribbon	cable.	

What if the Laser Line appears but is not projecting as a clean 
line? 

This	problem	is	very	common	once	a	scanner	head	has	been	finished	
and	is	and	ready	to	go	on	the	horizontal	guide.	The	first	step	towards	
solving it is to unscrew the laser control unit and take out the laser lens-
es. Start by checking whether the glue has touched any part of the lens 
(the aspherical lens or the convex lens) edges. If the glue has found its 
way onto the surface of a lens, then this lens must be replaced.    Other-
wise clean both lenses thoroughly. The laser line should be clean again. 
For Changing the Laser Lenses Please refer to the section: Mounting 
the laser Module

What if the Laser intensity is lower than it should be?

This kind of problem can only be spotted once all the preparation steps 
are done and the scanner head is ready for calibration. At this point the 
laser intensity must be lowered to its minimum value which is “1” (this
is why the calibration plate has a shiny metallic surface – the intensity 
value of “1” should be enough)
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The	laser	should	appear	as	a	clearly	defined	white	line	in	the	camera	
window. There is a problem if the line is dim or dark grey. However, it is
best to carry on with the calibration and make sure that there is really a 
problem. When there is an evident problem no response will occur on 
the screen after pressing the “Pulse” button and the software will crash. 
Now you are sure there is a problem with the laser diode. If the process 
is repeated at a higher laser intensity, the calibration should work – but 
this not a solution.

A weak laser will later affect the scanning of dark surfaces and lead to 
data loss in the darker shades of the spectrum. The only solution is to 
change the laser diode.

Note: It is not necessary to change the entire copper plate or PBC 
board and would rather be considered a waste. For changing the laser 
diode please refer to section 15. 

What if the scanner head – including the laser – was perfectly as-

sembled but during calibration or scanning the software crashed 

or the scanner head moved without any information showing on 

the screen?

In this situation, the problem is probably related to the video wires con-
necting the two cameras to the trigger board. To ensure that the prob-
lem is coming from the video wires, test another scanner head with the 
wires from the malfunctioning head. If the problem persists then the 
video wires must be replaced.

Note: If you test the wires using the voltmeter, they might show positive 
results but if they are not functioning properly with the head, then they 
must be changed

What if the camera view in the settings tab detects the signal 

more slowly than it should?

In this situation check the USB port that is used for the slow Camer-
a(s), as the problem could be that the USB ports used for both cam-
eras are sharing the same power supply on the computer and this will 
show a failure in detecting the signal. In this case, the cameras start 
performing poorly. You can solve this problem by plugging the camera 
USB in a different port.

8. Assembly components

This section lists the major components required to assemble the Lu-
cida scanning head. 

1. Camera bar 2. Laser structure

3. Laser lens protection 
plate
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4. Camera bar on connection plate

5. Connection plate

6. Camera holder 7. Aspherical lens-holder

8. Convex lens 9. Convex lens-holder 11. Camera lenses

10. Laser diode

12. Copper plate - front 13. Copper plate - back 14. Cable tray bracket

9. Assembly tools

1. Lens handling tweezers 2. Allen key set

3. Cutter

6. Laser lens adjusting plastic tube

4. Cleaning air pump

5. Hammer

7. Solder and tin 8. Araldite glue 
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Assembling the Lucida control unit

Components:

3 controllers   An Arduino Board
10 M3x8 Screws   An Acrylic Base
Power Supply Cable (200 cm) Flat Ribbon Cable (15 cm)
4 Conductor Cable (600 cm) 1 Ferrite for Power Supply Cable 
1 Ferrite for Flat Ribbon Cable 
2 Ferrites for Flat Ribbon Cable divisions
3 Motor connectors

Tools:

A solder   Tin
Allen Key  Flat head screw driver

1. Place the three controllers and Arduino board in their correspond-
ing locations on the acrylic base, then attach them using the 10 M3x8 
screws. Tighten the screws.

Note: Make sure that the Acrylic Base is placed on the right before 
positioning the screws.

2.	Prepare	15	cm	of	flat	ribbon	cable.

3.	On	one	end	of	the	cable	place	a	Ferrite	and	fix	a	connector,	plac-
ing the red cable on the right side while connected to the PBC board. 
The	 flat	 ribbon	 cable	will	 have	10	wire	 divisions,	 but	 only	 the	 first	
seven will be needed.

5. Once each wire is placed in its location tighten the screw. For wire 
N.	5	and	wire	N.	6	fit	on	them	a	small	Ferrite	 to	reduce	signal	noise	
before placing them each in the corresponding socket.

6. Now prepare two 2.5 cm sections of the power supply cable

7. The power supply cable is made of two divisions one black and the 
other red. The black one will be used as the ground cable and the red 
one as the voltage cable. Separate the voltage and ground wires that 
you have prepared then place them in their sockets, as shown on the 
diagram above.

8. Then prepare 2-meter-long power supply cable. Place one end of the 
cable in the sockets on the third controller where the arrows are located 
on the diagram. Then solder the other end to the round connector.

Now start working on the motor wires...

As with the previous tutorial on assembling the Lucida head, this tutorial 
is only designed as a reminder for someone who has already assem-
bled several control units with the help of one of Factum's operators. It 
takes the user through the steps required with the aid of diagrams. 

4.	Separate	the	first	seven	wires,	starting	with	the	red	edge	as		N.	1	and	
place them in the sockets at the head of the 3 Controllers in
the order shown in the diagram below:
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9. Prepare 3 sections of a conductor cable each 1.5m – 2m long (the 
length is dependent on the job that the set will be used for).

10. When the 3 wires are ready remove from each side 3cm – 4cm of 
the plastic coat, exposing the four inner wires on each side. 

11. Then remove a section of the coat around 0.5 mm long to expose 
the copper wire. Solder the wires onto the connectors in the following 
order:

Red   Red

Red + White  Yellow

Green   Blue

Green + White  White

Note:	if	the	colours	are	different	try	coming	up	with	the	best	fit	combina-
tion and remember to note it down

12. For the other end, place each conductor cable in a controller follow-
ing the order shown below:
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Appendix I: Types of  3D Scanning

It is essential that the right type of  
3D recording isundertaken for each 
heritage site or object and that the 
application is considered prior to 
the recording phase of  a project. A 
facsimile, for example, requires the 
acquisition of  very high-resolution 
data, with particular attention paid 
to the surface of  the object. How-
ever, in general, the more complete 
the dataset – a good dataset would 
comprise, for example, high-resolu-
tion colour, high-resolution surface 
texture as well as an accurate rendi-
tion of  shape – the more uses it will 
have for academic, conservation and 
research purposes. 

All systems used by Factum Arte 
and Factum Foundation are 100% 
non-contact and meet the highest 

A note about resolution

Comparison between the maximum resolution possible with the Faro LiDAR scanner (left) and a 
normal recording with the Lucida - King Seti I from the tomb of  Seti I, Luxor

At Factum, we use the term resolu-
tion to refer to the level of  detail held 
in a 3D file. We evaluate the resolu-
tion not just through a theoretical 
or mathematical description of  the 
sensor of  the scanner but by the de-
gree of  correspondence between the 
scanned data and the original sur-
face (see image below). A close-range 
scanner has greater correspondence 
to the surface of  the object than a 
longrange scanner. The main vari-
ables that affect the resolution are 
the lenses, the sensors, the area that 
is being scanned and the software 

conservation standards. The lighting 
used does not affect colour and at no 
time during the recording is there 

algorithms that process the data. 
Somewhere in this mix of  elements 
is the sweet-spot that will result in 
data that passes the 'mimesis test': 
if  it looks like a sweet that has been 
sucked it has failed - if  in direct com-
parison with the original it looks the 

Long-medium range 3D scanners 
(LiDar)

Long-medium range 3D scanners are 
used to record the general shape of  
objects and surfaces with the aim 
of  obtaining accurate metrological 
information Long-medium range 
scanners use time-of-flight or laser-
pulse based systems in which a laser 
light is bounced off  the target at a 
distance. A laser range-finder cal-
culates the distance to a surface by 
timing the round trip of  a pulse of  
light using the known value for the 
speed of  light. In cultural heritage 

documentation, long-medium range 
scanners are normally used in combi-
nation with closerange 3D scanners 
to generate models with both global 
metrological accuracy and high reso-
lution surface detail. 

What we use it for: topography and 
the recording of  buildings: we have 
used the FARO Focus3D X 330 in 
conjunction with ScanLAB Proj-
ects, London; to record the façade of  
San Petronio in Bologna; The Last 
Supper by Leonardo da Vinci; and 
the whole of  the refectory at Santa 
Maria Delle Grazie, Milan; 'mapping' 
the tomb of  Seti I (see below) 

We don’t use it for: recording the 
subtle detail of  surfaces – data that 
is required to make an accurate fac-
simile or for epigraphic study.

Render of  FARO 3D data from the Tomb of  Seti I, Luxor, made in 2016 
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Close-range 3D scanners

Close-range 3D scanners (working 
distance greater than 8 cm and less 
than 100 cm) are used to record the 
shape and surface of  objects in great 
detail. A shorter record ing distance 
is associated with higher resolution. 
Close-range scanners use either a 
laser or a structured light system. 
Triangulation based 3D laser scan-
ners use a laser light and one or two 
cameras to record a subject. The dis-
tance of  the object to the scanner is 
calculated through trigonometry to 
create a precise map of  the surface. 
Structured light scanners use pro-
jected patterns of  light instead of  a 
laser for triangulation – the camer-
a(s) records these patterns and cal-
culates the position of  every point in 
the field of  view. 

The output can be used both for 
study purposes – with screen-based 
applications – or for rematerialisa-
tion in a range of  different ways, 
including as tactile objects for the 
blind and partially sighted, facsimi-
le production and exhibition display. 

What we use it for: scanning the 
surface of  paintings and reliefs like 
the Hereford Mappa Mundi (see 
image) and Goya’s Black Paintings. 

Recording shape and surface of  
sculptures and complex forms like 
the tomb of  Tutankhamun, the hi-
eroglyphs on Tutankhamun’s sar-
cophagus, monitoring the decay 
on the surface of  the sculptures on 
the façade of  San Petronio or in the 
crumbling Romanesque cloisters in 
Tudela.

What we don’t use it for: To re-
cord large structures for screen-
based viewing. Close range scanning 
is slower than long-medium range 
scanning or photogrammetry, which 
has to be taken into account when 
planning a recording session.

Render of  3D data of  the Hereford Mappa 
Mundi recorded with the Lucida 3D Scanner

Photogrammetry

Photogrammetry is the science of  
making measurementsfrom photo-
graphs to obtain 3D information 
about an object or landscape. It has 
been used since the birth of  modern 
photography in fields such as topo-
graphical mapping, architecture, and 
archaeology – examples of  long-range 
photogrammetry. Factum's work and 
research is currently focused on close-
range photogrammetry as a means 
to record the form and texture of  
surfaces and objects at high-reso-
lution. Data is being recorded with 
commercially available cameras that 
are used to capture multiple shots of  
the entire surface of  an object; it is 
possible to obtain high quality data 
with very little equipment. Due to 
the composite nature of  the image 
capture, both colour and form can 
be extracted from the data – it is im-
portant to note, however, that soft-
ware limitations currently mean that 
high-resolution colour data is difficult 
to extract. Although basic processing 
is required in the field, the recording 
process is less time-consuming than 
with close-range scanning systems. 

What we use it for: quick recording 
of  vulnerable and relatively inacces-
sible sites it is the ideal method for 
obtaining 3D information in situa-
tions where it is not possible to use 3D 
scanners, or when high-speed record-
ing is required. It can also be used for 
recording translucent surfaces such 
as alabaster and marble. Factum has 

applied this technology to record the 
Stelae at Nahr el Kalb in Lebanon 
and the alabaster sarcophagus of  
Seti I in Sir John Soane’s Museum. 
A nine-camera system designed and 
built in-house at Factum – the Veron-
ica Scanner – is capable of  recording 
objects up to 50x50x50 cm in approx-
imately 4 seconds.

What we don’t use it for: the high-
est resolution recording of  surface 
for facsimile production; featureless, 
reflective or very dark surfaces also 
pose problems for photogrammetry.

Factum Arte considers it very like-
ly that, with software development 
currently underway, photogramme-
try will soon become the dominant 
method for recording at risk cultural 
heritage in 3D and colour.

3D rendering of  the Stelae to Esarhaddon 688 
- 699 BC in Nahr El Kalb, Lebanon; recorded 

and processed with photogrammetry.
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Scanning systems used by Factum
A catalogue of  scanners used and an evaluation 
of  their performance

1. Faro Focus3D X 330

The FARO Focus3DX 330 laser scan-
ner (a LiDAR scanner) records a 360° 
environment of  its surroundings. 

At Factum Arte, the FARO has been 
used, in conjunction with ScanLAB 
Project, as a complementary tool to 
create an accurate digital canvas of  
a space, on to which high-resolution 
surface scans are placed.

The Faro Focus3D X 330

Scans generated from FARO Focus3DX 330 in the tomb of  Seti I Valley of  the Kings, Luxor

Technique: Time-of-flight / laser pulse-
based 3D scanner

Operation: 1 person. Skill level: Moder-
ate; survey and geomatic based back-
ground required/

Recording distance: Long-medium 
range (0.6 m-330m)

Processing: Extensive and requires both 
skill and artistry. Skill level: Expert; 
geomatic and digital visualization expe-
rience necessary

Resolution: Dependent on the level of  
detail required and proximity to object; 
1 million to 750 million points per scan

Applications: Documentation of  in-
door/outdoor environments e.g. archae-
ological sites, buildings

Correspondence to target surface: Rela-
tively low

Advantages:
• Small, lightweight instrument
• Long range, non-invasive capture 

of  large features
• A 70 megapixel camera records co-

lour and overlays photographs for 
a more detailed

Recording time: Depend ent on resolu-
tion and quality settings; 30 seconds – 2 
hours per scan/

Limitations:
• Does not capture high resolution 

data of  the texture and surface 
of  an object (limiting its use for 
the production of  facsimiles or in-
depth study)

• Divergence of  resolution at range
• Processing requires an expert skill 

level
• Glossy, reflective and translucent 

surfaces are difficult to scan/

Processing time: Depends on the data 
and desired output but on average very 
long

Data applications: 3D walkthroughs of  
environments or buildings, screen based 
imaging, 3D printing, survey archaeo-
logical sites, etc

File formats: Native scan format is 
.FLS; exports in point cloud format/

Equipment: Terrestrial LiDAR scanner, 
survey tripod and tribarch, camera and 
panomaker, reference geometry/targets/

Environmental Conditions: Overcast, 
even lighting, avoid di rect sunlight and 
rain
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2. Nub 3D SIDIO Scanner

Factum Arte has worked exten-
sively with Nub3D – a company 
based in Barcelona, and which 
developed the SIDIO scanner – 
since 2006. 

The SIDIO is one of  Factum’s 
most useful systems because as it 
captures the full geometry of  ob-
jects with high surface detail and 
outputs the data in clean point 
cloud formats.

Nub 3D structured light scanner recording the west 
side of  the sarcophagus in the  Tomb of  Tutankha-

mun, Valley of  the Kings, west bank, Luxor, 
Egypt.

3D scanning of  Paolina Borghese using NUB 3D SIDIO Scanner, Galleria Borghese 
Rome, April 2013.

Technique: Structured light scanner Processing skill level: Expert

Recording distance: Close range; 30 
cm / 60 cm / 1 m (each corresponds 
to a different area)

Maximum recording size: 50cm² per 
scan session.

Resolution: 75, 130 or 250 microns Applications: precision scanning of  
sculptures, reliefs, rocks, facades etc.

Correspondence to target surface: 
Very high

Advantages:
• Automatically pre-aligns on site with 

marker system
• Accurate and high quality measure-

ment
• Data is clean and ordered point cloud
• Control over post processing and 

mesh generation

Recording Time: Dependent on vari-
ables such as shutter speed, charac-
teristics of  the object etc., but over-
all quick (a few seconds per scan)

Limitations:
• Heavy, a lot of  equipment, need 

space to operate
• Not good for dark, translucent, re-

flective surfaces
• Halogen light generates significant 

heat
• Sensitive to vibrations
• Needs mains power
• Expensive hardware and software
• Complex calibration system
• Only one camera

Processing Time: The processing 
time depends on the complexity of  
the object scanned

Data applications: Screen based ap-
plications, 3D printing, re-material-
isation, reverse engineering, indepth 
study.

Equipment: 3 tripods, scanner, 2 ex-
ternal projectors, powerful desktop, 
calibration rail, calibration plates

Operation: 1 operator (2 ideal) Skill 
level: Moderate

Environmental Conditions: low 
light, no vibrations

File formats: Point cloud; native fo 
mat: TRI; has to be exported as PIF 
and input into post-processing
software like Polyworks
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3. Breuckmann Smart Scan 3D

The Breuckmann outputs 
high-resolution 3D meshes and is 
used in Factum Arte for a variety 
of  artistic and conservation proj-
ects. 

The Breuckmann, and similar 
systems, are used widely because 
of  their accurate, but simple re-
cording and processing methods.

Tests were conducted with the Breuckmann on the Bronze Oak but the tree´s texture made it 
impossible to record the entire tree using only this method. 

Photogrammetry was used to complement the data 

Setting up a Breuckmann 3D scanner in 
Henry Hudson's studio to scan a maquette

Technique: Structured light scanner Processing skill level: moderate (1 
person)

Recording distance: Around 1 m Maximum recording size: 1m² per 
scan session.

Resolution: 75, 130 or 250 micr 140 
microns for 30x30 cm2/shot; 250 mi-
crons for a 60x60 cm2/shot. 

Sculptures, objects, reliefs, facades 

etc.

Correspondence to target surface: 
Very high

Advantages:
• Captures colour (res. 0.8-2.0-8.0 MP)
• Waits for vibrations to stop before 

scan
• No need to use markers for combingin 

scans
• Two camera system
• Can do photogrammetry-structured 

light combined measurement
• LED light does not generate heat
• Software aligns scan immediately 

and offers model preview

Recording Time: Dependent on res-
olution but overall faster than the 
SIDIO

Limitations:
• Cannot access point clour as the 

system is designed to output 3D 
meshes through OPTOCAD soft-
ware

• Calibration plate large
• Needs mains power
• Expensive

Processing Time: faster than SIDIO Data applications: Screen based appli-
cations, rapid prototyping, re-material-
isation.

Equipment: Scanner, tripod, laptop 
with powerful GPU and min. 32 GB 
RAM (OPTOCAD software uses RAM 
memory to build meshes), calibration 
tools

Operation: 1 operator (2 ideal) Skill 
level: Moderate

Environmental Conditions: low 
light, no vibrations
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3. Lucida 3D Scanner 

Lucida is a 3D laser scanner de-
signed and developed by the art-
ist Manuel Franquelo and custom 
built by Factum Arte. 

It obtains high resolution record-
ings of  the surfaces of  works of  
art and low relief  objects. This 
system has been developed to ob-
tain 3D information of  surface 
and texture, not colour.

Lucida recording the Hereford Mappa Mundi, 
Hereford Cathedral

The Triumph of  the Eucharist by Rubens (at the Prado Museum)over Idolatry, 3D render, from 
data    recorded by Lucida detail of  the cracks and paintbrush relief, including detail of  perimeter 

of  later addition

Technique: Triangulation based 3D 
laser scanner

Processing skill level: basic (1 person)

Recording distance:Close range (8-
10 cm)

Maximum recording size: Dependent 
on the structural frame

Resolution: 100 microns (10,000 
points per cm²)

Applications: Walls, frescoes, rock 
art, paintings (canvas, board etc.), 
maps, fabrics (tapestries), manu-
scripts, coins, wax seals etc.

Correspondence to target surface: 
Very high

Advantages:
• Record a variety of  surfaces that are 

problematic for other 3D scanners 
(e.g. shiny, highly contrasted, gold or 
metallic surfaces)

• Saves data as unprocessed raw video
• Automatically outputs 3D data ren-

dered as 2D shaded images
• Data can be combined with other 

datasets (e.g. UV, infrared, colour etc.)
• Portable, easy to assemble and oper-

ate; relatively inexpensive
•  Mains or battery operated
• The software for scanning, editing 

and stitching has been designed to be 
open source

Recording Time: 4 hours per m² Limitations:
• Sensitive to vibrations and strong 

directional light
• Limited depth of  field (2.5 cm); for 

higher reliefs, several scans at vari-
ous distances are needed

• Slow scanning speed
• Cannot record transparent or 

translucent surfaces

Processing Time: 4-6 hours per m² (de-
pendent on computer processing power 
and experience of  the operator

Data applications: Re-materialization 
of  the relief  (CNC milling) for the cre-
ation of  exact facsimiles; screen based 
imaging in combination with other lay-
ers of  data (colour, etc

Equipment: Equipment: Lightweight 
CNC frame and controller, scanning 
head (pocket sized), laptop

Operation: 1 operator (2 ideal) Skill 
level: Basic

Environmental Conditions: low 
light, no vibrations

File formats: AVI (raw video), RIS, 32 
bit TIFF, 8 bit TIFF (shaded render)
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Appendix II: A selection of  projects by the Lucida 3D 
Scanner

Challenging 3D scanning: How do 
you scan a black glossy surface that 
is adjacent to a white glossy surface, 
or a tooled gold surface? Paintings 
have specific qualities that require 
focused solutions. Lucida is the 
3D scanner specifically created for 
recording the surface of  paintings 
and low-relief  objects.

Rubens: The Triumph of  the 
Eucharist over Idolatry

The first prototype of  the Lucida 
was used in the Museo del Prado 
in Madrid to digitise the surface 
of  a painting that was about to 
undergo a major restoration. 

This panel (65 x 91 cm) is one of  
a series painted by Rubens as pre-
paratory sketches for the tapestry 
cycle The Triumph of  the Eucha-
rist. 

Lucida was used to record the re-
lief  of  the front of  the panel at 
a resolution of  100 microns. The 
colour was recorded with a Clauss 
panoramic photography system.  
The 3D information that was ob-
tained is now of  great value as 
the shape, size and texture of  the 
painting changed significantly 
during the restoration process. 

It is unusual that size changes 
dramatically but in this case a 

previous addition of  several centi-
metres on each side of  the paint-
ing was removed. The restoration 
was intended to stabilize the paint 
and wooden panel before it was 
exhibited in front of  the tapestry 
that was based on the design. The 
recording was done in conjunction 
with the curatorial and conserva-
tion teams at the Museo del Prado. 

The data has now become an im-
portant part of  the history of  the 
painting and was supplied to the 
museum both as a digital archive 
and as a physically routed plaster 
panel. 

In line with Factum Foundation’s 
commitment to conservation the 
copyright on this data and on all 
future applications of  the data be-
longs to the owner of  the artwork.

The 3D information of  this paint-
ing obtained by Lucida is the only 
accurate record that exists of  the 
shape and texture of  the board 
before its latest restoration, after 
which the size and curve of  the 
material have changed signifi-
cantly. This is why it is essential 
to record the surface of  paintings 
before and after every restoration 
process. 

The Triumph of  the 
Eucharist  over Idolatry 
at the Prado Museum

The Triumph of  the 
Eucharist  over Idolatry, 
3D render

The Triumph of  the 
Eucharist over Idolatry, 
3D render, detail of  the 
cracks and paintbrush 
relief, including detail 
of  perimeter of  later ad-
dition
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The relief  data of  the painting recorded with Lucida was CNC routed in high resolution, and
then reproduced in plaster. the panel’s perimeter.

The plaster cast reproduction was included in the exhibition Rubens: the Triumph of
Eucharist in the Museo del Prado (Madrid) in 2014.

Hereford Mappa Mundi

High resolution digital documenta-
tion of  our shared cultural heritage 
is an essential in its conservation. 
Alongside the duty to preserve and 
disseminate artworks, we also have 
the responsibility to faithfully digi-
tise their physical characteristics, 
thus maintaining a record for fu-
ture generations. Lucida has been 
designed to help make this possible. 

In early 2013, a team from Factum 
Arte made a high resolution record-
ing of  the Hereford Mappa-Mundi 
(c. 1300) at the request of  Hereford 
Cathedral and the Trustees of  the 
Mappa Mundi. The glass cover is 

only removed once every two years 
for inspection, which made study-
ing the map a complex task. The 
team used the Lucida 3D scanner 
mounted onto a custom designed 
structure to provide absolute safety 
to the map and a firm platform for 
the highly accurate no-contact sur-
face scanning process. Each frame 
was post-processed to create the 
high resolution three-dimension-
al record. The three dimensional 
“map” of  the surface of  the Mappa 
Mundi will provide scholars, cura-
tors and the public with a safe and 
novel method of  studying and look-
ing at this extraordinary object. 

The Hereford Mappa-Mun-
di c. 1300
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By studying the 3D recording in 
conjunction with other methods 
of  forensic study, new discov-
eries have been made about the 
map including compass points in 
the centre of  Jerusalem and in 
the centre of  the Labyrinth of  
Crete. Further research is being 
carried out on the data, and may 
suggest that the map was made 
in Hereford and rather than in 
Lincoln. Thanks to the physical 
reproduction of  the high-resolu-

tion 3D data, visitors to Hereford 
Cathedral, including the blind 
and partially sighted, have the 
opportunity to explore and expe-
rience the map as never before. In 
addition, a new website that fea-
tures an interactive exploration 
area for the Mappa Mundi has 
just been launched, providing ac-
cess to the Folio Society digitally 
enhanced version of  the Map and 
the Factum Arte three-dimen-
sional surface scan.

Lucida 3D scanner 
recording the Mappa 
Mundi.

Lucida 3D scanner 
recording the Mappa 
Mundi

Lucida is not just concerned with 
shape, but with both shape and 
relief, and the complexity of  the 
surface texture. This intimate un-
derstanding of  surface is leading to 
new insights about how an artwork 
has changed, how it has been looked 
after, how it has been valued and 
what has been done to it over the 
centuries...

3D render of  the Hereford Mappa Mundi’s surface data.

The goal is the acquisition of  a re-
liable, high-resolution and dimen-
sionally accurate map of  the tex-
ture that can be studied on screen 
or re-materialized in the physical 
domain. If  data can be re-material-
ized with the exact characteristics 
of  the original, it is clear evidence 
of  the quality of  the data.
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Detail from 3D output 
–   the routed texture in 
resin

3D render section 
of  the  Hereford Mappa 
Mundi’s surface data.

3D facsimile of  
Hereford Mappa Mundi. 
Plaster cast of  the 
surface

Installation of  the Mappa Mundi’s repro-
duction in the Hereford Cathedral.

The backboard was 
recorded in 2016 
with Lucida and 
photogrammetry. 
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Polittico Griffoni: Digital technology applied to re-unify a scattered 
altarpiece

The restoration of  the chapel of  Saint 
Vincent in the Basilica di San Petro-
nio (Bologna) has provided scholars 
with a chance to re-consider an al-
tarpiece originally painted for the 
chapel: the Polittico Griffoni – one 
of  the most important masterpieces 
of  the Renaissance, painted between 
1471 and 1472 by Francesco del Cossa 
and Ercole de’Roberti. The work was 
commissioned by the original patrons 
of  the chapel, the Griffoni family, but 
was removed, dismembered and sold 
when the chapel came to the Aldro-
vandi family in 1725. The sixteen sur-
viving panels are in nine museums in 
different parts of  the world. 

In the period 2012-2015, the surfaces 
of  the sixteen panels of  the Polittico 
Griffoni were recorded in three dimen-
sions with the Lucida and the colour 
photographically captured at high 
resolution. To obtain the high-reso-
lution colour data, Factum Arte used 
a planar system to record the small 
panels and a panoramic photograph-
ic system to record the larger panels. 
Large numbers of  photographs are 
taken and stitched together using 
PTGui software. Recent develop-
ments in both hardware and software 
are opening up new possibilities for 
macro-photographic recording that 
allows the paintings to be studied 

The re-unified panels of  the Polittico Griffoni in the Factum 
workshop, Madrid 

The Lucida 3D Scanner recording the Annunciation Angel and Annunciation Virgin at
the Museo di Villa Cagnola, Gazzada, Italy in 2012
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Francesco del Cossa, San Vincenzo Ferrer, c. 
1473, The National Gallery, London

3D render of  data recorded by 
Lucida

Left: Ercole de’Rober-
ti, Saint George, 
c.1472,  Fondazione 
Giorgio Cini, Venice

Right: CNC milled; 
data recorded with  
Lucida

Front and back of  the Ercole de'Roberti; CNC 
milled into high density resin 

Detail from back milled in CNC 
resin
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with forensic accuracy. The resulting 
archives are evidence that the appli-
cation of  technology can ensure that 
cultural artefacts can be documented, 
studied and transmitted in a faithful 
way.

With the data recorded for all the 
panels, a physical reconstruction of  
the altarpiece will be made. This will 
be symbolically ‘returned’ to Bologna 
in October 2017 and housed in the 
Griffoni chapel where the work will 
be visible again in its original context.

This project is also an example of  
how high-resolution data can be used 
to monitor the state of  an object 
throughout a restoration process. The 
panels in the Pinacoteca di Brera, Mi-
lan, are currently undergoing resto-
ration to consolidate the paint surface 
and address the curved nature of  the 
poplar. After the restoration process, 
the panels will be recorded again, to 
monitor the changes and establish a 
comparison that will be of  great val-
ue for historians, researchers and con-
servators in the future.

Printing tests for high-resolution colour data at Factum, Madrid. The colour data will be re-in-
tegrated with the 3D data recorded by Lucida. 

The Gough Map

The Gough Map, kept at the Bodleian 
Library in Oxford, is one of  the earli-
est maps to show the British Isles in 
a geographically recognizable form. 
Dating from the midfourteenth cen-
tury, it is regarded as the oldest route 
map of  the country. Factum Arte is 
currently involved in a new initiative 
involving the Bodleian Library in 
Oxford and Queen Mary University 
to scan this fascinating object. Its 
exact dating, authorship and func-
tion are unknown and with the data 
resulting from the scanning process, 
researchers are hoping to shed light 

on these and many other aspects of  
its creation.

Factum Arte is committed to demon-
strating the importance of  digital 
technology in the analysis and doc-
umentation of  our cultural heritage. 
Noncontact, high-resolution 3D scan-
ning will provide valuable data of  the 
subtle relief  of  the map, which can 
then be combined with other layers 
of  information such as colour in order 
to monitor its condition and under-
stand its biography.

The Gough Map of  
Great Britain, 3D 
render of  the front 
by Lucida

The Gough Map of  
Great Britain, orig-
inal 56 x 115 cm, 
Bodleian Library, 
Oxford, combination 
of  3D render and co-
lour of  the front
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The Teschen Table

In July 2015, a team from Factum 
Arte recorded the Table of  Teschen 
(pictured on the right) at the Musée 
du Louvre, in order to make an exact 
copy to be shown in the Chateau de 
Breteuil – where the table has been 
kept since it was given to the family 
in 1768. 

The scanning of  the table was car-
ried out using various 3D and colour 
recording systems. Lucida was used 
to digitize some of  the main decora-
tive motifs across the table’s body, as 
well as one full leg. The recorded data 
was combined with the general 3D 
model of  the object generated with 

a structured light scanner. Whereas 
scanning translucent materials such 
as crystal or some of  the stones is an 
almost impossible task for most 3D 
scanners including Lucida, this proj-
ect demonstrated the ability of  the 
scanner to record data from gilded 
surfaces, with the highest quality 
and resemblance to the real texture 
of  the object. In order to record the 
curved surface on the leg, which ex-
ceeded Lucida’s depth of  field (25 
mm), various successive scans were 
made at different distances, and 
then merged in the processing phase 
to  complete the model.

Left: Facsimile of  the Te-
schen Table

Right: Render of  3D data of  
one leg of  the table recorded 
with the Lucida



Lucida Lucida252 253

Contact us

Support

factum@factum-arte.com

If you ever need help with your Lucida, email the address above. To 
help us understand the problem it is very helpful to include pictures 
or a video as attachments with your email. 

You can also telephone us: +34 915 500 978

Feedback

factum@factum-arte.com

For general questions or for your comments and ideas send an email 
to the address above. 

For more information

www.factum-arte.com
www.factumfoundation.org


